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Preface

The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available
on your network from which you can access the Agile PLM documentation (PDF) files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals
in both Agile Web Client and Agile Java Client. If you need additional assistance or information,
please contact support http://www.oracle.com/agile/support.html
(http://www.oracle.com/agile/support.html) for assistance.

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.htmi

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.
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Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Introduction

This chapter includes the following:

5 ADOUL AQIIE POIIEE SEIVICES ...vuevvrceeisicieisi ettt sss s 1
B WWNAES NBW. ottt et b bbb b bbb bbb bbb b s e bbb bbb bbb e e bbbttt st s e s 3
5 IBM WEDSPREIE POMAI SEIVET ..ottt 3
= Portlet Communication and CollADOALION ..ot 3

About Agile Portlet Services

A portal is a Web site that provides internal and external users with a single point of access to a
company’s Web-based resources. The portal’s single sign-on provides access to any number of
small applications, called portlets, that let users manage various types of information. Users can
personalize their own portal pages, making the portal more efficient, usable, and highly tailored to
meet their individual needs.

A portal usually contains several portlets. Each portlet provides users access to specific content or
actions. Agile provides several predefined portlets that can be integrated with a company’s portal.
Agile Portlet Services expose commonly-used Agile PLM functionality through a company’s portal
and allow users to quickly link to specific Agile product content.

The following figure shows a simplified portal system, one that does not include load balancers,
application server clusters, proxy Web servers, or LDAP servers.

Simplified portal system

HTTP(s) HTTP(s)
<> <> Portal
Clients
Database Server Agile Application Server WebSphere Portal S:ver\\
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Agile Portlet Services includes the following portlets:

Agile Portlets

Category Portlet Description
Search Advanced Search Searches for Agile PLM objects by matching one or more
field values.

Quick Search Searches for Agile PLM objects by specifying a single
matching value.

Saved Search Displays results for a saved search.

Search Folder Browser Allows you to browse search folders and select a
particular search to run.

Search Results Works in conjunction with Advanced Search, Quick
Search, and Search Folder Browser portlets. When you
click a search in search portlet, the results appear in the
Search Results portlet.

Content Attachment Files Shows a selected Attachments table for objects.

Business Object Shows an Agile PLM business object (such as an item or
change) to view or modify its fields.

Productivity My Notifications Shows the current user's Agile PLM notifications.

My Things to Do Shows lists of things the current user needs to complete,
including Action ltems, Program Activities, Requests, and
Workflow Routings.

Utility Bookmarks Shows the current user's Agile PLM bookmarks.

Clipboard Lets you collect Agile PLM objects to later perform
actions on them.

Quick Links Lets you add links to other portal pages or to external
Web pages.

Quick Navigation Lets you navigate to bookmarked or recently visited Agile
PLM objects, or display the contents of the Clipboard.

Report Folder Browser Lets you generate a report from one of the Report
folders.

Single Signon Allows you to enter a user ID and password to enable
single signon between the portal and the Agile PLM
server.

Upload File Adds a new file to the Agile PLM system.

User Profile Lets you view and edit your Agile PLM user profile

Page - 2 Agile Product Lifecycle Management
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What’s New

Agile Portlet Services provides the following new features with Agile PLM 9.2.2.4:
= Multiple Values Selection - The User can now filter available values based on string criteria.
= Advanced Search Portlet - The User can now select multiple values to search on a single list field.

= My Bookmarks and Quick Navigations Portlets - The User can now select the folder that the
bookmark will be added. The User can create a new folder and delete bookmarks and folders.

@ My Things to Do Portlet - This portlet now has My Request.

= My Notifications and Requests Portlet - This portlet is now named My Notifications. The Request
portion was moved to the My Things to Do Portlet.

IBM WebSphere Portal Server

Agile Portlet Services are currently supported on IBM WebSphere Portal.

For complete WebSphere Portal installation instructions, hardware and software requirements, and
configuration and troubleshooting information, please see the IBM WebSphere Portal InfoCenter.
Use any of the following methods to access the IBM WebSphere Portal InfoCenter:

@ Click the InfoCenter button available in the WebSphere Portal installation program.

@ Go to the WebSphere Portal InfoCenter URL.
®*  WebSphere Portal 6.01: http://publib.boulder.ibm.com/infocenter/wspshelp/index.jsp

o After WebSphere Portal is installed, click Start All Programs, select IBM WebSphere, select Portal
Server and finally select Information Center.

Portlet Communication and Collaboration

Agile portlets communicate with each other using portlet actions and portlet messages. The portlets
work together to share information with each other. For example, the Search Results portlet works
with one of the Search portlets (such as the Quick Search portlet) to display a table of search
results. If you click one of the search results, the object’s contents can appear in a Business Object
portlet on the same page.

Note You can control whether Business Obiject portlet clears the portlet of its contents if the
message received from another portlet (such as a Search portlet) is not supported. For
more information, see Setting Agile Portlet Parameters.

Page - 3






Chapter 2
Installing and Upgrading Agile Portlet Services

This chapter includes the following:
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Installation Sequence

These instructions assume you have purchased the required hardware and software, and installed
IBM WebSphere Portal as well as Agile PLM 9.2.2.5 before beginning to install Agile Portlet
Services.

To install and configure Agile Portlet Services:

1. Install Agile PLM 9.2.2.5 and all its server-side components (database, file server, LDAP
server, and so on). Agile Portlet Services connect to the Agile Application Server and cannot
work without it.

For detailed instructions on how to install the Agile Application Server, see the separate Agile
PLM installation guide.

Install IBM WebSphere Portal on a separate server from the Agile Application Server.
Install Agile Portlet Services (AgilePortletPack2.war) on the WebSphere Portal Server.

Configure Agile Portlet Services application parameters.

o > w N

If you are not using an LDAP server to authenticate users, create portal users and user groups.
Otherwise, configure the Portal Server to use an LDAP server for authentication.

6. Set up the Agile Portlet Configurator on a Web server so that portlet administrators can launch
it to configure portlets easily.

7. Create separate portal pages that use the Agile portlets. Some Agile portlets require
configuration before they can be used.

Agile Product Lifecycle Management Page -5
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Note On a portal page, add the Agile Single Signon portlet. You can then
personalize the portlet to log into the Agile PLM server, otherwise, you will not
be able to use the Agile portlets.

8. Configure each of the Agile portlets, especially those based on the Business Object portlet. For
Business Obiject portlets, you can edit each portlet's XML configuration or use the separate
Agile Portlet Configurator application.

Note The WebSphere Portal Server XML configuration interface can be used to
transfer the configuration of one portal to another. This is useful when moving
from a development environment to a production environment. For more
information about the XML configuration interface, see Exporting and
Importing Portal Configurations using the XML Configuration Interface (see
"Exporting and Importing Portal Configurations using XML Configuration
Interface" on page 45), as well as the IBM WebSphere Portal InfoCenter.

Installing IBM WebSphere Portal

Because WebSphere Portal ships with multiple software components and works with other
database, Web server, and LDAP server products, there are many different installation scenarios.
For complete installation instructions, please see the IBM WebSphere Portal InfoCenter.

To install WebSphere Portal:
Insert the WebSphere Portal Setup CD and follow the onscreen instructions.

Important Do not install WebSphere Portal Server into a path with spaces (such as “d:\Program
Files\WebSphere”).

Installing WebSphere Application Server and IBM HTTP Server as a
Windows Service

If you are going to run WebSphere Application Server and IBM HTTP Server (if you are installing it)
as a Windows service, you must install the product as a user with the following local policy rights:
o Act as part of the operating system

@ Log on as a service

The WebSphere Portal installer assigns these local policy rights to your account automatically, but
you will need to log out and log in again before continuing the installation.

Web Server Considerations

You can install the Web server on the portal machine or on a separate machine. If you install the
Web server on a remote server, you should also consider installing the WebSphere Application
Server plug-in, which takes care of load balancing between remote Application Server instances in
a clustered environment. The plug-in will also allow you to change the WebSphere Portal URI.

For more information about WebSphere Application Server plug-in, see the IBM WebSphere Portal
InfoCenter.

Page - 6 Agile Product Lifecycle Management
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Launching and Verifying the WebSphere Portal

The best way to verify that WebSphere Portal has been installed and is working properly is to
launch your portal and sign in.

To launch WebSphere Portal:
1. Make sure the Web server and WebSphere Portal server are running.

2. Open a browser and go to the WebSphere Portal URL:
http://<hostname>:<port>/<baseURI>/<homepage>

For example, if you accepted the default values during installation, enter the following URI:
http://<hostname>:10038/wps/myportal
The portal should load in the browser.

3. Click Log In. Enter the administrative user ID and password. Click Log In.

If you have trouble either loading the WebSphere Portal in the browser or logging in as the
administrator, see the IBM WebSphere Portal InfoCenter for troubleshooting information.

Configuring the WebSphere Portal for LDAP

If you install an LDAP server to manage users for the Agile Application Server, you can also use it
for authentication on the WebSphere Portal. The same LDAP users can then access both systems.

If the portal server will be integrated with LDAP, install the software as a user that exists within the
LDAP environment. Note the user ID and password so that you can install WebSphere Fix Packs
when necessary.

For more information about setting up LDAP for the WebSphere Portal, see the IBM WebSphere
Portal InfoCenter.

Creating Portal Users and User Groups

On a production server, WebSphere Portal supports authentication using an LDAP accessible
directory. Ordinarily, you would use the same LDAP server to maintain users for both the Agile
Application Server and the WebSphere Portal, thereby simplifying authentication for both systems.
If you install WebSphere Portal for the purposes of portlet development, an LDAP directory is not
required. In such an installation scenario, the portal administrator must define the users and user
groups that use Agile Portlet Services. On a development server, users and user groups are stored
in the WebSphere Portal database.

The portal administrator can use the Access Control List portlet to control the access rights that
users and user groups have for all portal resources, such as pages, and portlets. You can assign
different access rights to each user or user group for each type of resource. Users in a group inherit
the access rights assigned to the group.

For more information about WebSphere access control, see the IBM WebSphere Portal InfoCenter.

To create a portal user:
1. Select Administration, select Access, then select Users and Groups.
2. Click the link for All Authenticated Portal Users.

Page - 7



Portlet Services Installation and Configuration Guide

Click New User.

4. Enter values for User ID, Password, Confirm Password, First Name, and Last Name, which are all
required fields. For Preferred Language, select English. Optionally, specify the user’'s email
address. Click OK.

To create a user group:

Select Administration > Access > Users and Groups.

Click the Root link if it is not already selected.

Click New Group.

Type a name in the Group Name field, and then click Create Group.

In the User Groups list, click the name of the group you just created. Click Add Member.

2 T o

Select users by checking the Select box to the left of the user name. Click OK.

To assign access rights to users and user groups:

Select Administration > Access > User and Group Permissions. See User and Group Permissions
portlet help for detailed instructions on using the portlet.

Note If you do not assign access rights to users, they will not be able to view Agile
portlets and pages. Only the portal administrator will have rights to those
resources.

Installing Agile Portlet Services

Based on the license key you used to install Agile PLM 9.2.2.5 and its service packs, Agile Portlet
Services are automatically installed on the Agile Application Server. All Agile portlets are contained
in one file, AgilePortletPack2.war. Once you install the file, you must use WebSphere Portal
Administration to install the portlets on the portal.

To install Agile Portlet Services on WebhSphere Portal 6.01:

1. Install Agile PLM 9.2.2.5. For installation instructions, refer to the separate Agile PLM
installation guide.

Agile Portlet Services files are installed into the agile_home\Portlet_51 folder on the Agile
Application Server.

2. Onthe Agile Application Server, open a browser window and go to the WebSphere Portal URL.
The default URL is: http://hostname:10038/wps/myportal

Click Log In. Enter the administrative user ID and password. Click Log In.
Select Administration > Portlet Management > Web Modules > Install.

Click the Browse button to select the AgilePortletPack2.war file located in the
agile_home\Portlet_51\war folder on the Agile Application Server.

6. Click Next.
The page lists the Agile portlets that will be installed from the WAR file you selected.
7. Click Install.
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Setting Agile Portlet Services Application Parameters

Agile Portlet Services has several application parameters that are crucial to the successful

operation of all Agile portlets. If any one of the application parameters is configured incorrectly, it

can cause the portlets to malfunction or fail to connect to the Agile PLM server.

To set Agile Portlet Services application parameters on WebSphere Portal 6.0.1:

1. After Agile portlets are installed, log into the WebSphere Portal as an administrative user.
Select Administration, select Portlet Management, then select Applications.

2
3. Search for “AgilePortlets 2.1".
4. Click the [#] Edit Portlet Application icon.
5. Specify parameters shown in the table below.
* The parameter values are read-only. To change a parameter value, do this:
* Copy the parameter name, and paste it into a text editor (such as Notepad).
®  Click the '] Delete Parameter icon to remove the parameter. Click OK to confirm.
* Click OK to save changes.
e Click the [#]Edit Portlet Application icon again.
* Copy the parameter name from the text editor, and paste it into the New Parameter text box.
® Enter the new value for this parameter in the New Value text box.

®* Click to add the new parameter.

6. When you are finished modifying parameters, click OK.

Parameter Description

VaultSlotName This is the name of the Credential Vault slot. Agile's Single Signon
Portlet creates a slot with this name in the Credential Vault
automatically. The default slot name is AgilePLMSlot.

Note: Generally, you should not modify the value for VaultSlotName. If
you specify a different slot name, you will need to create all user
credentials again.

download.javaPlugin.url Enter the location of the Java plugin to use for client-side browsers. The
Gantt Chart applet uses this URL to download Java Runtime
Environment (JRE) version 1.4.2 if the client computer does not have
the proper version installed.

Default: http://java.sun.com/j2se/1.4.2/download.html

UnzipFilesOnUpload If you upload a ZIP file to the Agile File Management server, this
parameter determines whether a checkbox option will appear in the
portlet to allow you to unzip the file automatically. Enter true (the
default) or false.
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Parameter Description

portletConfiguratorURL Enter the URL for the Portlet Configurator JNLP file. This URL makes it
possible to launch the Portlet Configurator applet from the Business
Object portlet configuration page to configure Agile portlets. Otherwise,
you can configure Agile portlets by editing the XML configuration file.

Example:http://plm.company.com/configurator/configurator.jnlp

portalAdministratorEmail Enter the email address of the portal administrator. This address is
used to notify the portal administrator of any errors that occur with Agile
portlets.

createMultipleFileFoldersOn- If you upload files to the Agile File Management server, this parameter

Upload determines whether a checkbox option will appear in the portlet to

allows you to add the files to one file folder or multiple file folders. Enter
true (the default) or false.

help.base.url Enter the base URL for the Web server location where Agile portlets
access online help files. Each portlet can be configured to access a
specific help file located relative to this base URL.

Example:http://iportalserver/PortletsHelp

ppm.weekendDays Enter two comma-delimited integers that represent the days of the
week that are considered weekends by the Agile Product Portfolio
Management (PPM) solution. Weekend days are not counted when
Agile PLM calculates start and end dates based on the number of
business days estimated for a task.

Here is the list of integers for the days of the week:
0=Sunday

1=Monday

2=Tuesday

3=Wednesday

4=Thursday

5=Friday

6=Saturday

Default: 0,6
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Parameter Description

proxy.server.url Enter the URL used to connect to the Agile server. Enter the URL in this
format:

Format:<protocol>://<serverName>:<port>/<virtualPath>
where
o protocol is HTTP or HTTPS.

@ serverName is the name of the Agile PLM server
computer, not the proxy server.

@ portis the port number used for the specified server.
Default ports are:

IBM WebSphere Application Server = 9080
Oracle Application Server = 7777

@ virtualPath is the virtual path for your Agile server. The
virtual path is specified when the Agile system is
installed. By default, the virtual path is “Agile”.

Examples:
Oracle Application Server: http://plm.company.com:7777/Agile

server.timeout The Agile PLM server session timeout value. Do not confuse this with
the portal session timeout. The Agile PLM server will timeout after a
specified number of minutes. The portal administrator can use this
parameter to align the session timeout from Agile portlets with that of
the Agile PLM server.

To specify a timeout value, enter a positive number in minutes. To use
the same timeout setting as the application server, specify a negative
value. To never timeout, enter zero (0).

Default: 60 (minutes)

Setting Application Parameters for Copies of Agile Portlets

When you make a copy of a portlet, such as the Business Object portlet or Advanced Search
portlet, WebSphere Portal Server also makes a copy of the portlet application, along with its
application parameters. If you subsequently make a change to the portlet application parameters,
you must make the same change to every copy of the portlet application.

Note When you copy a portlet and consequently make a copy of the AgilePortlets application,
you can rename the new application to identify the portlet it is associated with.

Setting Up the Agile Portlet Configurator

The Agile Portlet Configurator provides an easy-to-use graphical user interface for configuring the
Business Object portlets, which has many configuration options. When you install Agile Portlet
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Services, the Agile Portlet Configurator files are installed into the following folder:

m]

WebSphere Portal 6.0.1: agile_home\Portlet_51\configurator

Before you can launch the Agile Portlet Configurator applet, you need to add the files to your Web
server and perform some configuration steps. You can use the Agile Portlet Configurator to
configure only Agile Business Object and User Profile portlets. It cannot be used to configure other

portlets.

To set up the Agile Portlet Configurator:

1.

Configure your Web server so that it handles JNLP files. This is necessary so that Java Web
Start can successfully download the application classes from the network and install it on your
computer. For instructions on setting the JNLP MIME type for both 1IS and Apache Web
servers, see “Configuring the JNLP MIME Type” below.

Web Server Default docroot directory
Internet Information Server (IIS) c:\InetPub\wwwroot
IBM HTTP Server c:\IBMHttpServer\htdocs
Apache Web Server c:\Apache\htdocs

In the <docroot>\configurator folder, open the configurator.jnlp file, and change the codebase
and href parameters in the jnlp tag to reference the correct locations on your Web server. See
the text in bold below. After you edit the file, save it.

<?xml version="1.0" encoding="utf-8"?>

< jnlp spec="1.0+" codebase="http://webserver/configurator"
href="http://webserver/configurator/configurator.ijnlp">

<information>
Product CollaborationAgile Portlet Configurator</title>
<vendor>Agile Software Corporation</vendor>
<description>Agile Portlet Configurator</description>

<description kind="tooltip">Agile Portlet
Configurator</description>

<!--<icon href="photonpc64.gif"/>-->
<offline-allowed/>

</information>

<security>
<all-permissions/>

</security>

<resources>
<j2se version="1.3+" max-heap-size="640m"/>
<jar href="configurator.jar"/>

<jar href="AgileAPI.jar"/>
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<jar href="crimson.jar"/>

<jar href="jaxp.jar"/>

<jar href="xalan.jar"/>
</resources>

<application-desc main-class=
"com.agile.ui.portal.portlets.bizObject.configure.PortletConfiguration
Applet">

</application-desc>
</jnlp>

Set the portletConfiguratorURL parameter for Agile Portlet Services to the same URL you used in
the previous step. For instructions on how to change the portletConfiguratorURL application
parameter, see Setting Agile Portlet Services Application Parameters.

Test whether the Agile Portlet Configurator is working by opening a browser and typing the
following URL:

http://Web Server/configurator/configurator.jnlp

The Portlet Configurator login dialog box appears.

Note If the Portlet Configurator does not load successfully, make sure the URLs
specified in the configurator.jnlp file and the portletConfiguratorURL parameter
match one another and are correct. Also, make sure Java Runtime
Environment (JRE) 1.4.2 or later is installed on the client machine. For more
troubleshooting information about the Portlet Configurator, see
Troubleshooting.

To log in, enter a valid Agile PLM user name and password. For the Server URL, type the
same URL used for the serverURL application parameter (for example,
http://plm.company.com:7777/Agile). Click OK.

The Portlet Configurator window appears.

Configuring the JNLP MIME Type

A JNLP file is an XML document that describes a Java application to be launched by Java Web
Start. To successfully download and install applications using Java Web Start, you must configure
the JNLP MIME type for your server.

To configure the JNLP MIME type on Windows:

1.

Choose Start > All Programs > Administrative Tools > Internet Information Services (IIS) Manager.
The Internet Information Services (IIS) Manager window appears.
Expand the folder for Internet Information Services > servername.

Select the Web Sites > Default Web Site folder, right-click, and choose Properties from the shortcut
menu.

The Default Web Site Properties dialog box appears.
Click the HTTP Headers tab.
Click the MIME Types button.
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The MIME Types dialog box appears.
6. Click the New button.
In the Extension field, type jnlp. In the MIME Type field, type application/x-java-jnip-file. Click OK.

8. The new file type appears in the Registered MIME Types box. Click OK to close the MIME
Types dialog box.

9. Click OK to close the Default Web Site Properties dialog box.
10. Restart lIS.

To configure the MIME type on Solaris:
1. Locate the mime.types file in the conf directory of the Apache Web server.
2. Add the following line to the mime.types file:
application/x-java-jnip-file  JNLP
3. Restart the Apache Web server.

Upgrading Agile Portlet Services to Agile PLM 9.2.2.5

To upgrade an existing installation of Agile Portlet Services to 9.2.2.5, follow these steps:
1. Upgrade your Agile PLM application server and database to Agile PLM 9.2.2.5.
2. (Optional) Upgrade from WebSphere Portal Express 5.022 to WebSphere Portal 6.0.1.

3. Log into the WebSphere Portal as an administrator and uninstall any existing Agile PLM 9.0 or
9.1 portlets.

4. Install new Agile PLM 9.2.2.5 portlets. For instructions, see Installing Agile Portlet Services.

Set application parameters for Agile Portlet Services.For more details, see Setting Agile Portlet
Services Application Parameters.

6. Update Agile PLM portlet pages for your portal.

7. If you configured the Business Object Portlet for your portal, you can update XML configuration
files to the Agile PLM 9.2.2.5 format using the XML Upgrade Tool.

Using the XML Upgrade Tool

The XML Upgrade Tool is a simple command-line Java utility for upgrading Business Object Portlet
XML configuration files from earlier versions to 9.2. The main difference in the Business Object
Portlet configuration is that it now supports configurations for multiple classes. You can use the
XML Upgrade Tool to convert an old XML configuration file to the new format. You can also
concatenate multiple XML configuration files together into one new XML file.

To update an existing Business Object Portlet XML configuration file to Agile 9.2.2.5 format:
1. Onthe computer where Agile Portlet Services are installed, open a command prompt window.

2. Change to the XML Upgrade Tool folder:
®  WebSphere Portal 6.01: agile_home\Portlet_51\xmlupgradetool
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3. Run the following command:

java -classpath ./XMLUpgradeTool.jar;./jdom.jar
com.agile.uil.portal.portlets.bizObject.configure.tools.XMLUpgradeTool
filel [ file2...filen]

At least one input file argument is required. Files must use fully qualified paths, such as
c:\temp\bopl.xml. Separate multiple files with spaces. If you specify multiple files, the XML Upgrade
Tool combines them into one output file.

The output file is created in the same directory where you ran the XML Upgrade Tool. The name of
the output file is the concatentation of the input filenames plus “_<release version>.xml".

The following example shows how to combine two files named bopl.xml and bop2.xml into a new
output file named bopl.xml_bop2.xml_9222.xml.

java -classpath ./XMLUpgradeTool.jar;./jdom.jar
com.agile.uil.portal.portlets.bizObject.configure.tools.XMLUpgradeTool
c:\temp\bopl.xml c:\temp\bop2.xml

After you create the new Agile 9.2.2.5 XML configuration file, you can copy it into the Portlet
Configurator to configure an Agile 9.2.2.5 Business Object Portlet.

Updating Agile Portlet Services

If you receive an updated Agile Portlet Services WAR file and you have already installed Agile
portlets on the WebSphere Portal, you do not need to reinstall them. Instead, follow these steps to
update Agile portlets.

To update the Agile Portlet Services WAR file on WebSphere Portal 6.0.1:

1. Open a browser window and go to the WebSphere Portal URL. The default URL is
http://<hostname>:10038/wps/myportal.

Click Log In. Enter the administrative user ID and password. Click Log In.

Select Administration, select Portlet Management, then select Web Modules.

Find AgilePortletPack2.war, and then click the |l Update Web Module icon.

Click the Browse button to select the updated AgilePortletPack2.war file. Click Next.

L

The Manage Web Modules page lists the portlets that will be updated from the WAR file you
selected. Click Finish to begin updating them.

7. Afterinstallation is finished, stop the WebSphere Portal and clear the Agile SDK cache on the
portal server. See the next section.

Clearing the Agile SDK Cache

Whenever you update the Agile Portlet Services WAR file by installing a new version, you must
clear the Agile SDK cache on the WebSphere Portal computer. When you delete the Agile SDK
cache, it forces Agile portlets to use the network class loader to download the latest classes, which
allow Agile portlets to connect to the updated Agile 9.2.2.5 server.

To clear the Agile SDK cache:
1. Stop the WebSphere Portal.
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Open a Command Prompt window.
Change to the %temp% directory:
cd %temp%
4. Delete the Agile SDK cache subdirectory:
del AgileSDK.cache
5. You are prompted “Are you sure?” Enter Y for Yes.
Restart the WebSphere Portal.

Setting Agile Portlet Parameters

Before placing Agile portlets on a page to define the layout of your portal, you should set the
parameters for each portlet you intend to use.

To modify portlet parameters for WebSphere Portal 6.0.1:

Select Administration, select Portlet Management, then select Portlets.
Click the 1721 Configure Portlet icon for an Agile portlet. The Manage Portlets page appears.

1
2. For the parameter you want to change, click the [#] Edit Parameter icon.
3. Inthe Value field, enter a new value.

4. Click OK.

Note Several portlet parameters are designed to be modified only from the portal
page when the portlet is in Configure mode. To enter configure mode, go to the
portal page and click the portlet's # wrench icon. Other users can personalize
the portlet by clicking the +* pencil icon in the portlet’s title bar.

Parameter Description Agile Portlets
clearPortletContentslfMes If set to true, this parameter clears the Business
portlet of its contents if a message Object

received from another portlet (such as
a Search portlet) is not supported.

Default: false

customTitle An optional custom title for the portlet All
that appears in the portlet's title bar.
disableTableStatusFlags If set to true, the portlet disables Business
status flag attributes such as Has Object
Attachments and Has Action Items.
Saved
Default: false (status flag attributes Search
are enabled) Search
Results
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help.relativePath

The relative path of this portlet's help
file. The relative path is combined with
the help.base.url value to create the
complete URL for the help file.

Al

help.url

The complete URL for an online help
file for this portlet. This URL overrides
the URL specified by the
help.relative.path portlet parameter
and the help.base.url application
parameter.

All

mTTConfiguredViews

Specify the comma-delimited series of
selected views for the portlet.

Default: 1,0,2

0 = My Workflow Routings
1 =My Action Items

2 = My Activities

My Things
To Do

mTTPossibleViews

Specify the comma-delimited series of
possible views for the portlet.

Default: 1,0,2

0 = My Workflow Routings
1 =My Action ltems

2 = My Activities

My Things
To Do

notfConfiguredViews

Specify the comma-delimited series of
selected views for the portlet.

Default: 0,1
0 = My Notifications
1 =My Requests

My Notifications
and Requests

notfPossibleViews

Specify the comma-delimited series of
possible views for the portlet.

Default: 0,1
0 = My Notifications
1 =My Requests

My Notifications
and Requests

objectType

The currently selected Agile object
type used in the Advanced Search
portlet.

Not Supported. Use the portlet’s
Configure mode to configure it.

Advanced
Search
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pageid_Report_cstRptCfgEnabled Equivalent to the Enable Customer Report
External Reports checkbox in the Folder
portlet's Configure mode. A separate Browser

cstRptCfgEnabled parameter is
provided for each portal page on
which the Report Folder Browser
portlet has been added. Possible
values for the parameter are 0 (false)
and 1 (true).

Default: 0
pageid_Report_rootFolderld Select a report folder by specifying its Report
numeric ID. Folder

To find the ID number of a report Browser

folder, move the mouse over a folder
in the Report Folder Browser portlet.
The ID number appears in the
browser's status bar.

A separate rootFolderld parameter is
provided for each portal page on
which the Report Folder Browser
portlet has been added.

The portlet’s Configure mode offers
a much easier graphical user
interface for selecting a report
folder.
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portlet.messaging

Defines how the portlet communicates
with itself, the page, or other pages
when you click an object link in the
portlet. Specify one of the following
values:

Empty string (") — This is equivalent
to removing the portlet. messaging
parameter from the portlet, which
causes the default behavior to be
used. If you click a link for an object
supported by a Business Object
portlet, the portlet sends a message to
itself. For other objects not supported
by the Business Object portlet and for
all other portlets, the default behavior
is for the portlet to send a message to
the current page when you click an
object link.

"page" — The portlet sends a
message to the current page.

"none" - Object links in the portlet
appear as normal text. When you click
the text, the portlet does not send a
message.

An internal portal URL - If the
portlet.messaging parameter is not an
empty string, “page”, or “none”, the
portlet assumes the value is a URL
that has been mapped to another
portal page. The portlet sends the
object context to the portal page
identified by the URL. The URL must
be an internal portal page that uses
WebSphere's URL mapping. For more
information on how to use URL
mapping, see the IBM WebSphere
Portal InfoCenter.

Internal portal URLs are of the format:
Iwps/myportal/mypage

where mypage is the mapped URL for
the page. The internal portal URL is
appended to the portal prefix
(http://hostname:port).

Important: The URL mapping must be
all lower case.

When you click an object link in the
portlet, the context of the object is
attached to the URL as a querystring
parameter.

Note: Changes to the
portlet. messaging parameter do not

Attachment
Files

Business
Object

Bookmarks
Clipboard

My Notifications
and Requests
My Things

To Do

Saved
Search

Search
Results

User
Profile

take effect until you log out of the
portal and log in again (to clear the
cache).
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queryCriteria Defines the search criteria used for the | Advanced
Advanced Search portlet. Search
Not Supported. Use the portlet’s
Configure mode to configure it.
quickLinksXml Defines the XML configuration for the Quick
Quick Links portlet. Links
Not Supported. Use the portlet’s
Configure mode to configure it.
quickSearchinfoText Sample query information to help Quick
users enter a value to search forinthe | Search
Quick Search portlet. This sample
query text appears when you click the
Show Sample Queries link in the
portlet.
ReportServerSettingKeys Aggregates the keys that have been Report
set for all portal pages on which the Folder
Report Folder Browser has been Browser
added.
Not Supported. Use the portlet’s
Configure mode to configure it.
savedSearchld The ID number of a saved search. The | Quick
results of the search will appear in the Navigation
Quick Navigation portlet.
Not Supported. This parameter is
obsolete and does not affect the
Quick Navigation portlet.
scrollBarHeightLimit The height of portlet data. If portlet Quick
data exceeds the specified height, a Navigation
vertical scroll bar appears. Report
This parameter does not set the height | Folder
of the portlet. To do that, you must edit | Browser
the page layout. Search
Folder
Browser
scrollBarWidthLimit The width of portlet data. If portlet data | Quick
exceeds the specified width, a Navigation

horizontal scroll bar appears.

Search Folder

This parameter does not set the width Browser
of the portlet. To do that, you must edit
the page layout.

searchableAttributes The list of available attributes that can Advanced
be used in search criteria. Search

Not Supported. Use the portlet’s
Configure mode to configure it.
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searchConfigurationXML

Defines the XML configuration for the
Advanced Search portlet.

Not Supported. Use the portlet’s
Configure mode to configure it.

Advanced
Search

Search_savedSearchid

Select a saved search by specifying its
numeric ID.

To find the ID number for a saved
search, move the mouse over a saved
search in the Search Folder Browser
portlet. The ID number appears in the
browser’s status bar.

The portlet’s Configure mode offers
a much easier graphical user
interface for selecting a saved
search.

Saved
Search

searchDisplayAttributes

The list of available attributes that can
be used in search results.

Not Supported. Use the portlet’s
Configure mode to configure it.

Advanced
Search

simpleSearchinfoText

A brief message that provides
information about a Simple Search to
help users of this portlet.

Not Supported. Simple Search is no
longer an option of the Advanced
Search portlet.

Advanced
Search

supportedSearchTypes

Specify the Agile object types that can
be searched for in the Advanced
Search portlet.

Not Supported. Use the portlet’s
Configure mode to configure it.

Advanced
Search

tableHeight

The height of the table that appears in
the portlet. If the table exceeds the
specified height, a vertical scroll bar
appears.

To enable tableHeight and tableWidth
parameters, both must be set to
nonzero values.

Default: 0 (disabled)

This parameter does not set the height
of the portlet. To do that, you must edit
the page layout.

Business
Object

Saved
Search

Search
Results
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tableWidth The width of the table that appears in Business
the portlet. If the table exceeds the Object
specified width, a horizontal scroll bar
appears. Saved
Search

To enable tableHeight and tableWidth
parameters, both must be set to
nonzero values.

Default; 0 (disabled)

This parameter does not set the width
of the portlet. To do that, you must edit
the page layout.

Search
Results

Creating Portal Pages

Note Please consult the IBM WPS Help for the latest information.

The WebSphere Portal has a hierarchical structure of nodes. Each node is an element in the portal
navigation tree. There are three types of nodes:

o page — Displays content in the form of portlets.

o Jabel — Container for other nodes. Labels are used to group nodes in navigation.

= URL — An addressable resource, such as external Web pages or pages within the portal site.

The topmost node in the portal navigation tree is the content root. After you install WebSphere
Portal, the following nodes appear under the content root:

= My Portal — a label containing portlets for general use. This is the default page displayed after
login.

= Administration — a label used containing pages with portlets used to administer the WebSphere
Portal.

o Page Customizer — a label with child pages used to manage page content and layout.
o Page Properties — a page used to edit the properties of portal page.

= QOrganize Favorites — a page containing the Organize Favorites portlet, which lets portal users
organize their favorite labels and URLSs. You can access the Organize Favorites page using the
My Favorites list in the banner.

Users without administrative privileges can access only the My Portal node. Administrators can use
links in the banner to switch between Administration and My Portal.

A page displays content, or portlet applications. Each page can contain one or more portlets. To
view a page, first select the place. Once the place is selected, you can click a page within the place.

To create an Agile label in My Portal:

1. Select Administration, select Portal User Interface, then select Manage Pages.
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Click the My Portal label.
Click New Label.
Type Agile and click OK.

a > WD

The Properties page appears. Click OK.
To add a page to the Agile label:

1. Select Administration, select Portal User Interface, then select Manage Pages.

2. Select Content Root from the list, then select My Portal, and finally select Agile.
3. Click New Page.
4

Type the name of the page and click OK. For example, type Programs to create a page showing
Agile programs.

5. The Properties page appears. Click OK.

Note Portal pages can be imported from a portal configuration file using IBM’'s XML
Access tool. For more information, see Exporting and Importing Portal
Configurations using the XML Configuration Interface (see "Exporting and
Importing Portal Configurations using XML Configuration Interface” on page
45).

Editing the Layout of a Page

WebSphere Portal lets you control the layout of portal pages, select and arrange portlets on a page,
and edit portlets that require configuration.

Pages can contain columns, rows, and portlets. You can fill the columns and rows with portlets or
other columns and rows. You can also create nested pages.

To create a page with Agile portlets, you must select a logical group of portlets to display Agile
content. A page you create might include:

= the Single Signon portlet, which connects a user to the Agile PLM server. Only one Single
Signon portlet is needed for your portal. The same connection is used for all Agile portlets on
multiple pages.

o a Search portlet to locate Agile PLM content. Quick Search and Advanced Search are
examples of Search portlets.

o a Content portlet, such as a copy of the Business Object portlet, to display data for a selected
object.

To edit the layout of a portal page:
1. Select Administration, select Portal User Interface, then select Manage Pages.

2. Select a portal page to edit.

3. Click the [#] Edit Page Layout icon.

Some of the options you can select on the page include:

o Layout template: Select from several pre-configured page layouts.

o Add portlets: Select portlets to add to the page.
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= Show layout tools: Shows advanced layout tools for creating and editing page containers. This
option overrides the pre-configured layout templates. For example, you can set the column
width.

The following figure shows an example of a two-column layout for a page that includes the Single
Signon, Quick Search, Search Results, and Item (Business Object) portlets.

-

** Single Signon (Agile) £7 = 0 e pordat - 2800-03
agile welcome to Agile Custam Actions ¥
The Agile Credentials have been set for the User with Agile User ID - pm,
‘You can change the Agile Credentials by dicking the Edit Maode of this Portlet. Site: [ALL = | Rev: |PS CO0146 =
About Agile Portlets: B
Agile PLM Server:  httpi/fgrange. agile agilesoft corm: 7778/ Agile SELel
Build:  2005-06-02.13-08-23,115
Minirmurn Agile PLM Server Version:  Agile PLM 9, 1LASPL Weight
oy Quick Search (Agile) ? =0 Gize
Fev Release Date  04-May-2004
IItams d IzS* Rev Incorp Date
ey PSCO0T4E
I saarch ammachmant Contants Business Lnit Electronics - Consumer
Part Family
* R
" search Results (#gile) ? =0 Humber Sl
Liferyele Phaze  Prototype
EI Part Type * Aszembly
Quick Search Results Effectivity Date  04-May-2004
= Description * ZHP PDA 512/256
copy B wis W pookmark wore ¥ t3s KATELP M /
INameﬂ'Numbard | Filter | Show All
rll | | | states | actons|
r i zso0-03 ZAP PDA 512/296 Prottype [2) Conversion Factor
r I Z800-02 ZAP PDA 256/128 Prototype @
r# oz 24P PDA 128(64 Prototype 2
Rows per page : |10 'I
-
q 3

Administering Pages

The portal administrator can permit specified users to change the layout of a page. If you have
authority to change a page, select Administration, then select Manage Pages to modify the layout. For

each page, you can click the #I Set Page Permission icon to specify the permissions that users have
to edit the page.

For more detailed information about creating and modifying places and pages, see the “Managing
Pages, Layout, and Content” topic in the IBM WebSphere Portal InfoCenter.

Setting Resource Permissions

In addition to creating users and user groups, the portal administrator can specify permissions for all
types of portal resources, including pages and individual portlets. This allows the portal
administrator to set the level of personalization for each page or each portlet.

To access Resource Permissions for your portal, use one of these methods:

B Choose Administration, select Access, then select Resource Permissions.
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o Click Assign permissions in the page banner.

= Click the Set Permission icon in the Manage Pages portlet.

For more detailed information about setting resource permissions, see the “Authorization” topic in
the IBM WebSphere Portal InfoCenter.

Using Custom Themes and Skins

Portal pages also have themes and skins, which are usually created by the Web designer of the
portal. Themes control the look and feel of the portal, including colors and fonts. For each theme,
there are one or more skins that define the style of the area surrounding individual portlets. To set
the default theme and skin for the portal, select Administration > Portal User Interface > Themes and
Skins.

If you create custom themes or skins, you can test them on a development system. After the
themes and skins are fully developed and tested, you must update and redeploy the WebSphere
Portal EAR file with the new themes and skins.

For more information about custom themes and skins, see the IBM WebSphere Portal InfoCenter.

Agile PLM Administration Settings Related to Portlets

After Agile Portlet Services are successfully installed and configured, the Agile PLM administrator
must configure the application server to interface with the portal properly. The administrator must
perform the following tasks to ensure that Agile PLM users can launch the portal Web site from
email natifications they receive.

The Preferred Client user preference specifies which Agile PLM client to launch from email
notifications. The available choices are Java Client, Web Client, or Portal Client. The Preferred
Portal URL user preference specifies which portal URL to go to if the user selected Portal Client as
his preferred client.

For more information about Agile PLM administration, see the Agile PLM Administrator Guide.

To add a portal URL to the Agile PLM server:

Log into the Agile Java Client as an administrator.

Choose Admin. Select Server Settings, then select Locations and then select Portals.
Click the New toolbar button to add a portal URL.

In the Name field, type the name of the portal.

In the Portal field, type the portal URL.

In the Enabled list, select Yes.

Click OK.

N o g s~ w DR

To configure the Agile PLM portal as your preferred Agile PLM client for email notifications:
1. Log into the Agile Web Client.
2. Choose Admin > User Settings > Users.

3. Choose Tools > My Settings.
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Click User Profile.

Click the Preferences tab.

Click Edit.

Click the Preferred Client list and select Portal Client.
Click the Preferred Portal URL list and select a portal.
Click Save.

© © N o g &

Note If the Preferred Portal URL list reads “No Privilege,” make sure the Modify
Users privilege for Agile PLM applies to the “users.Preferences.Preferred
Portal URL" attribute.
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Configuring Agile Portlets

This chapter includes the following:

ADOUL POrtlet CONfIGUIALION. ......cuevieeieicreri st et nes b
POIIEE IMOUES. ..ottt bRt ettt
Configuring the Advanced SEArch POMIEL...........c..ccririirceresee s
Configuring @ QUICK LINKS POIIEL .........oo ittt
Configuring the Report Folder Browser Portlet
Using the Portlet Configurator
MeSSaging BEIWEEN POIIELS ..........ceiieeeicrriri ettt et

Exporting and Importing Portal Configurations using XML Configuration Interface............ocoovveveerenienenninnns 45
Using Process Extensions from Within PORIELS ..ot 46
Creating Custom Help for AGIle POMIELS ........coviriirceies e 49

About Portlet Configuration

This section describes how to configure Agile portlets. For most portlets, configuration is simple and
requires selecting just a few options. The Business Object and User Profile portlets, however, are
more complicated and have many more options for content and layout. You can configure those
portlets by editing the XML configuration or using the Portlet Configurator.

Once an Agile portlet is placed on a page, it can be used by people connecting to the portal.
However, the following Agile portlets must be configured before they can be used:

@ Advanced Search

o Business Object

B Quick Links

@ Saved Search

o Search Folder Browser

o User Profile

To configure a portlet from the page layout:

1. Select Administration, select Portal User Interface then select Manage Pages.
2. Select a portal page that uses Agile portlets.

3. Click the [#] Edit Page Layout icon.
4

Select an Agile portlet, such as one based on the Business Object portlet, and click the [#] Edit
Portlet icon.
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To configure a portlet from a portal page:
1. Select a portal page.

2. Click the Configure icon # (a wrench) for a portlet.

Portlet Modes

Each portlet has up to four possible display modes:
o View — Shows the portlet's normal user interface.

o Help — Shows a help window with information about the portlet. Although Agile Portlet Services
does not include online help, you can create your own custom online help for each Agile portlet.

o Edit — Shows a page that lets users personalize a portlet. Portlets that support Edit mode have
a # pencil icon.

= Configure — Shows a page that allows portal administrators to configure a portlet. Portlets that
support Configure mode have a # wrench icon.

Configuring the Advanced Search Portlet

The Advanced Search portlet has a graphical user interface for specifying its configuration, but it is
more complex than other Agile portlets, partly because it also requires that you are familiar with the
Agile API query language. This section steps you through the somewhat tricky process of
configuring an advanced search.

To configure the Advanced Search portlet:

1. Select a portal page with the Advanced Search portlet, and click the ¥ wrench icon to enter
Configure mode.

2. Inthe Select Class To Search list, select the class or subclass to search for.

If you select a base class (such as Items), a different set of search and display attributes can
be configured for each class. If you select a class (such as Parts), a different set of search and
display attributes can be configured for each subclass.

3. In the Define Search For list, select a class.

4. Select one or more attributes to include in the search parameters, and then click ¥ to move
them into the Selected Attributes box.

5. Select attributes to display in the search results, and then click % to move them into the
Selected Attributes box.

6. To exclude inactive list values from searches, make sure the Exclude inactive values for List
Attributes box is checked.

7. Click Update to update the search, Save to save the search and Return to return to the portlet.

Page - 28 Agile Product Lifecycle Management



Chapter 3

Configuring a Quick Links Portlet

The Quick Links portlet lets you set up a portlet with links to portal pages and external Web sites,
including other Web applications. The portlet uses the XML Configuration window to configure the

links.

The XML configuration for a Quick Links portlet has the following tags:

Tags Description Example

Product Collaboration Portlet header Product CollaborationExternal
Quick Links«</title>

<links> Container for links. <links>
<l--links go here-->
</links>

<link Link tag. If you are referencing a portal <link name="ViewMyPrograms"

name=name URL, the openinNewWindow parameter | openinNewWindow="false">

openinNewWindow=boolea
n>

should be set to false (the default). If you
are referencing an external URL, the
openinNewWindow parameter should
be set to true.

</link>

<link name="Yahoo"
openinNewWindow="true"></|
ink>

<label>

Label or description of the link.

<label>Yahoo</label>

<href>

A Web location (URL)

<href>http://lwww.agile.com</
href>

Here is an example of a Quick Links XML configuration file with links to several portal URLS:

<?xml version="1.0" encoding="UTF-8"?>

<links>

Product CollaborationProgram Quick Links...</title>
<link name="ViewMyPrograms">
<label>View My Programs</label>

<href>/wps/myportal/viewmyprograms</href>

</link>

<link name="UpdateTasks">
<label>View My Tasks</label>
<href>/wps/myportal /updatemytasks</href>

</1link>

<link name="UpdateActionItems">
<label>View My Action Items</label>
<href>/wps/myportal /myactionitems</href>

</1link>

<link name="CreateProgram">
<label>View New Program Creation</label>
<href>/wps/myportal/createprogram</href>

</1link>
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</links>

”

Note In the previous example, “viewmyprograms,” “updatemytasks,”
“myactionitems,” and “createprogram” are hames that have been mapped
internally to portal URLs. For information on how to use URL mapping on your
portal, see Setting Up Quick Links to Portal Pages (on page 30) below.

Here is another example of a Quick Links XML configuration file, this time with links to several
external URLs:

<?xml version="1.0" encoding="UTF-8"7?>

<links>

Product CollaborationHandy Web Links...</title>
<link name="Agile" openinNewWindow="true">
<label>Agile Software</label>
<href>http://www.agile.com</href>
</1link>

<link name="Yahoo" openlnNewWindow="true">
<label>Yahoo</label>
<href>http://www.yahoo.com</href>
</1link>

<link name="Google" openinNewWindow="true">
<label>Google</label>
<href>http://www.google.com</href>

</1link>
<link name="CNN" openinNewWindow="true">
<label>CNN</label>
<href>http://www.cnn.com</href>
</1link>
</links>

Setting Up Quick Links to Portal Pages

To set up Quick Links to portal pages, you must first create a URL mapping. URL mapping is a
feature of WebSphere Portal Server that allows portal administrators to define simple, easy-to-
remember URLs and map them to portal pages. The URL mapping creates a relationship on the
portal between a name and a portal page. To create a URL mapping, select Administration, select
Portal Settings, then select URL Mapping.

Important The URL mapping must be all lower case.

For more information on how to use URL mapping, see the IBM WebSphere Portal InfoCenter.

Configuring the Report Folder Browser Portlet

The Report Folder Browser portlet lets you generate reports from one of the Report folders. You
can configure the portlet to select a particular folder. Once you select a folder, the portlet allows
users to navigate to any reports in that folder and any subfolders.

To configure a Report Folder Browser portlet from a portal page:
1. Select a portal page that has the Report Folder Browser portlet.
2. Click the Configure icon = (a wrench) for the Report Folder Browser portlet.

3. Select a report folder from the Report Tree.
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Note This folder becomes the topmost folder that users can navigate to when they
personalize the portlet.

4. To enable customer external reports to be launched from the portlet, make sure the Enable
Customer External Reports box is checked.

Click Save to save the configuration.

Click Return to return to the portal page.

Using the Portlet Configurator

For Business Object or User Profile portlets, when you configure the portlet an XML Configuration
window appears. If you're familiar with XML and XSL (extensible stylesheet language for XML), you
may find it easy to edit the XML directly. However, if the XML seems too complicated, use the
Portlet Configurator to modify the configuration.

e b usiness Object Pordet (Agile) - 1000-02 1 ? - 0O
Edit the ML Configuration:
| Copy | | Paste | | Upload File Launch Configuratar
<?=ml wersion="1.0" encoding="UTF-8"?= -
<uiconfigs xralnsixsi="http fwww, w2 org/ 2001/ ¥MLEcherma-instance"=
<uicanfig id="0" name="Itams">
<agile-entity baseclassId="901">=
<subclass id="9141" />
<zubclass id="10141" /=
<fagile-entity>
<attribute-groups>
<attribute-group collapseGroupByDefault="falze" colurmn-count="1"
displayMamedsHeading="true" id="0" name="Title Block" ref-id="0">
“<attribute-unit classId="201" id="1001" narme="Nurmbear" /=
<attribute-unit classId="201" id="1002" narme="Description" /x>
<gttribute-unit classId="901" id="1021" narme="Itarn Type" />
<attribute-unit classId="2901" id="1014" name="Reu" />
<attribute-unit classId="901" id="2000004416" name="Part
Farnily" (=
<attribute-unit classId="901" id="1084" name="Lifecycle Phaze" />
<attribute-unit classId="201" id="1004" name="Product Line(=)" />
<fattribute-group>
</ attribute-gqroups>
<tables>
<table collapseByDefault="false" dizplayNarmepsHeading="true"
id="g07" narne="Attachments" ref-id="0">
<athribute-unit classId="9141" id="104&" name="Filename" />
<attribute-unit classId="9141" id="1045" narme="Fila
Description” /=
<attribute-unit classId="9141" id="1142" name="Cheackout Usar" /=
<attribute-unit classId="9141" id="1144" name="Checkout
Location /=
<attribute-unit classId="9141" id="11432" narme="Checkout Date" f>:|
| Save || Return |
[T Use defaule configuration
Note Configuration of the Business Object portlet should be done only by the portal

administrator. Consequently, the portal administrator should set resource
permissions so that ordinary users do not have permission to personalize the
Business Obiject portlet. For more information about resource permissions, see
Setting Resource Permissions (on page 24).
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The Portlet Configurator is a Java application that lets you configure Business Object and User
Profile portlets using a graphical user interface. Other portlets have simple configuration options, so
the Portlet Configurator is not needed for them.

The Portlet Configurator connects to the Agile PLM server to read business object classes,
attributes, tables and actions. After you specify general portlet properties, the content to use
(attribute groups, tables, and actions), and the layout, you can copy the XML configuration data
from the Portlet Configurator to the portlet's XML Configuration window.

Roles and Privileges Needed to Use Agile Portlet Configuratior

The Agile Portlet Configurator requires read-access to metadata tables for all Agile PLM classes
and subclasses to configure Business Object portlets. Therefore, you should have Administrator
privileges to use it. If you do not have Administrator privileges, see your Agile PLM administrator.

Launching the Agile Portlet Configurator

When you connect to the Agile Portlet Configurator Web site, it uses Java WebStart technology to
deploy the application to your computer. After that, you can launch the Portlet Configurator from
your computer’s desktop.

You can also launch the Portlet Configurator from the XML Configurator window of a Business
Object or User Profile portlet.

To launch the Portlet Configurator from a portlet:
1. Select Administration, select Portal User Interface, then select Manage Pages.
Select a portal page that uses Agile portlets.

2
3. Click the [#] Edit Page Layout icon.
4

Select an Agile portlet, such as one based on the Business Object portlet, and click the 1#] Edit
Portlet icon.

5. Instead of editing the XML configuration file for the portlet, click the Launch Configurator link. The
Portlet Configurator login dialog box appears. After you log in, the Portlet Configurator appears
in its own window.

Portlet Configurator Toolbar

The Portlet Configurator has the following toolbar buttons:

Button Command Description
Equivalent
i File > New Clears any current configuration to create a new configuration. If the
previous configuration was not saved, you will be prompted to save it.
= File > Open Opens an existing XML configuration file.
File > Save Saves the current configuration to an XML file.
T Edit > Copy XML Copies the XML from the current configuration to the user’s Clipboard.
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Button Command Description

Equivalent

Edit > Paste XML | Pastes XML from the Clipboard to the current configuration. If there is a
current configuration, you will be prompted to overwrite it.

Portlet Configurator Tabs

The Portlet Configurator has three tabs:

m]

Classes — Lets you select the classes and subclasses for the portlet, as well as specify the
portlet title

Configure — Lets you define the content and layout of the Business Object portlet.

XML — Lets you view or edit the XML for the portlet configuration.

Portlet Configurator Navigation

The Configure tab of the Portlet Configurator has a navigation pane on the left side of the window
that lets you quickly switch between the different panes. To switch to a different pane, just click the
pane you want in the navigation pane.

Using Portlet Configurator to Modify a Configuration

If a Business Object portlet has already been configured, you may want to modify the existing
configuration rather starting over with a new configuration. Use the Copy and Paste buttons to edit
the existing configuration in the Portlet Configurator.

To modify an existing portlet configuration:

1.
2.

Select a portal page.

Click the Configure icon # (a wrench) for a Business Object or a User Profile portlet that has
already been configured. The XML Configuration window appears.

Note If the portlet has not been configured yet, the XML Configuration window is
empty. If the portlet has been configured, click Copy to copy the configuration to
the clipboard.

Click Launch Configurator to start the Portlet Configurator.

In the Login dialog box, enter your username, password, and Agile PLM server URL. Click OK.

Click @ Paste.

Click the Configure tab.
Specify the Content and Layout of the portlet.

Click E Copy.
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9.

10.
11.
12.

Note Optionally, you can click Save to save the portlet configuration to an XML
file so that you can open it later.

Switch to the portlet’'s XML Configuration window.
Click Paste.
Click Save.

Click Return to return to the portal page.

Using the Classes Tab

For each Business Object portlet, you must specify the classes and subclasses supported by the
portlet. You can also specify a title for the portlet. To set portlet classes and its title, click the Classes
tab (by default, the first tab selected). The following options appear:

m]

Portlet Title — The title that appears within the skin of the portlet window. It should identify the
type of business object that appears within the portlet.

Object Class — The Agile PLM class used by the portlet. After you select a class, click Add to
add it to the Defined Class Views list.

The Business Object portlet supports the following Agile PLM classes:
o Changes

®  File Folders

= |tems

@ Manufacturer Parts

@ Manufacturers

=@ Programs

o Reports

& User Groups

Additionally, the Portlet Configurator allows you to configure the Users class to support the
User Profile portlet.

Note The actual base classes supported by your Agile PLM system depend on the
Agile PLM solutions your company has purchased. However, only the above
classes have been certified to be used with Agile portlets.

Available Subclasses — Based on the selected object class, this list shows the available
subclasses that can be selected.

Selected Subclasses — Subclasses selected for this portlet. By default, all subclasses are
selected. However, you can disable a subclass for the portlet by deselecting it.

Defined Class Views — Lists the object classes that have been added to the portlet configuration.
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Using the Configure Tab

The Configure tab is where you specify the content and layout of the portlet for a particular base
class. Before you can specify the content and layout, you must select a class in the Configure for
Base Class list.

Classes Configure | XML |

Configure for Base Class

There are three types of content you can specify for the portlet:

= Attribute Groups — Sets how Page One, Page Two, and Page Three attributes are grouped
within the portlet.

o Tables — Sets which tables are used in the portlet, and the columns that appear in each table.

o Action Groups — Sets the action buttons that appear in the portlet.
Attribute Groups

Business object classes and subclasses can have many attributes visible on Page One, Page Two,
and Page Three. Therefore, to provide a more usable portlet interface you should assign the
attributes to meaningful groups. The same attribute can appear in multiple groups, if you prefer. To
set attribute groups, click Attribute Groups in the navigation pane of the Portlet Configurator. The
following options appear:

o Attribute Group Name — Name of the group of attributes.

= Display Name as Heading — Check this box to display the attribute group name as a heading for
that area of the portlet.

= Collapse Group by Default — Check this box to collapse the attribute group and show only its
name. By default, the group is fully expanded.

= Number of Columns — Specifies the number of columns used to display the attributes. Select one
or two.

o Filter — Displays a subset of attributes. Available filters are:
* All Page One
* Al Page Two
* All Page Three

® <Subclass> (includes all Page One, Page Two, and Page Three attributes for a particular
subclass)

= Available Attributes — Displays the list of available attributes based on the currently selected filter.

Note Although the User Group > Assignment > Date Group Table attribute is listed in the
Available Attributes list, it is not supported by Agile portlets.

o Selected Attributes — Select attribute to add to the attribute group.
= Add button — Adds the new attribute group.

= Update button — Updates the selected attribute group with the current settings.
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o Delete (X) button) — Deletes the selected attribute group.

The following figure shows an attribute group that has been defined for Page One attributes.

ﬂportlet Configurator

Fle Edit

)

=

@] B]a]

Classes Configure | v |

Configure for Base Class IItems j

Content

Ettrihute Gmués

Tables
Action Groups
Layaut

Attribute Group Name: |Page One
IV Digplay Name as Heading

[~ Collapse Group by Default

Murnber of Colummns: |1 i I
All Page One j

Available Atributes Selected Attributes
Compliance Calculated Date huimber a
Exclude fram Rollup Description o
(verall Compliance [tem Type
Part Family ~ | lRev
Rev Incarp Date < | Product Line(s)
Rev Release Date Size o
CShippable Iterm
[Mass j

]

Updats ==

-ifribute Groups

Tables

Based on a portlet’s object class, there are several tables you can choose to display in the portlet.
You can specify which tables should appear in the portlet and the columns or fields that appear in

each table. To configure the content of tables, click Tables in the navigation pane of the Portlet
Configurator. The following options appear:

B Choose Table — Select a table from the list.

= Display Name — Name of the table.

o Display Name as Heading — Check this box to display the table name as a heading for that area of

the portlet.

o Collapse by Default — Check this box to collapse the table and show only its name. By default, the

table is fully expanded.
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o Available Columns — Displays the list of available columns based for the selected table.
= Selected Columns — Selects columns to add to the table configuration. Columns appear in the
portlet in the order they are listed.
Note To change the order of columns, select a column and click j or ﬂ to move
it up or down.
o Add button — Adds the new table configuration.
@ Update button — Updates the selected table configuration with the current settings.

o Delete (X) button) — Deletes the selected table configuration.

The following figure shows how the Change Orders.Affected Items table has been configured.

ﬁportlet Configurator ng&
Fle Edi

s|#|e| bl

Classes Configure ||

Canfigurs for Base Class |Changes j

Content
Attrbuts GOUPs chopss Table: IChange Ordlers. Affected] Trems j

Action Groups Display Name: |Aﬁected Items
Layout

~Tables

v Digplay Narne a5 Heading
™ Collapsa By Default

Auailable Columns Selected Columns
A =2 |
Field ﬂ Ttemm Nurmber
Finiched Gaods Tiem Description Updte > | ﬂ
Has Been Redlined (mage MNew Rey
Has PSR (Image) : Sites T
Manfachurer (mage) Effective Date
EE “ | |Charige Function i
(Obsolete Date Lifecycle Phase
0ld Lifecycle Phase &

Action Groups

When you configure a Business Obiject portlet, you can enable an Actions toolbar with buttons and
menu commands for object-level actions. These actions apply to the entire object. You can select
which actions are available in the portlet and organize them into functional groups.

The actions that you can select for the portlet depend on the object class. They can include:

= Common actions (Bookmark, Delete, New, Print, SaveAs, Send, Subscribe, Edit,
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u]

u]

CopyToClipboard)

Workflow actions (Approve, Audit Release, Audit Status, Comment, Change Status, and Reject)
File Folder actions (Check In, Check Out, Cancel CheckOut, and Download)

Class-specific actions (such as Incorporate and Unincorporate for Items)

Process extensions

Many of these actions can be grouped together. Two of them, Change Status and New, can only
exist in their own action groups.

To define action groups, click Action Groups in the navigation pane of the Portlet Configurator. The
following options appear:

u]

u]

Action Group — Enter the name of the action group.

Number of Actions to Display as Buttons — Specifies how many actions to display as buttons. If you
select 0, all actions will appear in a menu with the same name as the action group. If you select
a number greater than 0 but less than the number of actions in the group, the additional actions
will be listed in a menu with the name “More.”

Available Actions — Displays the list of available actions for the object class.
Selected Actions — Select actions to add to the group. Actions appear in the portlet in the order
they are listed.

Note To change the order of actions, select a column and click j or ﬂ to move it
up or down.

Rename — Renames the selected action. If you change the name of an action, the original Agile
name appears to the right of it in parentheses.

New Action — Adds a new process extension action to the Available Actions list. For more
information, see Using Process Extensions from within Portlets (on page 46).

Add button — Adds the new actions group.
Update button — Updates the selected action group with the current settings.

Delete (X) button) — Deletes the selected action group.
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The following figure shows an actions group that has been defined for Workflow Actions.

g Portlet Configurator o |D |ﬂ
File Edit
S EEE
Classes Configure | . |
Configure for Base Class IChanges j
Contentl ~fiction Groups
fttribute Groups | | | ction Group IWorkﬂow drtions ,
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Bookmark, fpprove
Delete Reject
e it Release
Print it Status
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5end ¥
Subscribe # “ | Update > |
Edit ¢ ; i
CopyToClipboard
change Status
Fiename Mew Action

The following figure shows how the Actions toolbar looks in the portlet. Notice that New Object,
Change Status, and Common Actions display as drop-down menus, and Workflow Actions only
shows two buttons because the Number Of Actions to Deploy As Buttons option has been set to 2. The

remaining actions in the Workflow Actions group, Audit Release, Audit Status, and Comment,
appear on the More drop-down menu.

Mew Object ™ I Change Status ™ | common actions = | Ef H Maore ™

Adding the Edit Action to an Actions Group

The Edit action is important because it allows users to edit an object that appears in the Business

Object portlet. If you do not add the Edit action to any Actions Groups, the Business Object portlet
will be read-only for all users.

Even if the Edit action has been added to Business Object portlet, it may be read-only for some
users. Agile PLM privileges determine whether a user has rights to modify an object. If you do not
have the Modify privilege for a particular object, the Edit action is disabled.
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Adding the Change Status Action to an Actions Group

The Change Status action for routable objects is a special action that behaves differently from other
actions. If you add the Change Status action to an action group, it dynamically generates the list of
status types from the object class and adds them to the Actions toolbar. However, the workflow
status actions replace all other actions you may have selected for that actions group.

If you choose to use the Change Status action, make sure it is the only action in the group. You can
call the group Change Status.

Adding the New Action to an Actions Group

The New action allows you to create any of the objects that the portlet supports. The New action
appears as a drop-down menu in the Business Object portlet.

Change Status ™ | Mew Ohject ™ | cormrmon actions « | ET H

File Folders
ftem
Chagl:?s

The New action cannot be grouped with other actions. It must be the single action added to a group.
If you add the New action to a group with other actions, it will not appear in the portlet.

23450 : Relea

Page Cne

Note The New action is not supported by User Profile portlet and Report objects.
Consequently, you cannot use Agile portlets to create users or reports.

When you create a new object within the Business Object portlet, the portlet usually displays a New
Object dialog box with the fields needed to define the new object (such as the subclass and object
number).

mBusinessObjectpnrtlet[.ﬂ.gile:l 4 & 7 - 0
SubClass: ECO -

Mumber/Hare: ICIIIIIIIIIIIIl 123

Create || Cancel |

If the portlet supports only one subclass and one autonumber sequence and an autonumber is
required, the New Object dialog box does not appear and the object is created using the next
autonumber.

Portlet Layout

After specifying the properties and content of a Business Object portlet, you can configure the
portlet layout. To define the layout, click Layout in the navigation pane of the Portlet Configurator.
The Layout window allows you to:

o Construct a portlet header.
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u]

u]

Select the layout template to be used.

Arrange the attribute groups and tables within the layout.

The following options appear in the Layout window:

u]

Display Object Status — Check this box to display the object’s status at the top right of the portlet.
If the Actions toolbar is shown, the status appears below it.

Use Portlet Header — Check this box to display a custom header at the top left of the portlet. If the
Actions toolbar is shown, the portlet header appears below it.

Construct Header — Use the list of attributes to the right to add Page One attributes to the header.
In that way, you can display the object’'s Number, Description, Status, or other Page One
attributes in the header. You can also type attributes directly in the field, such as [Number]:
[Description of Change].

Add — Adds the selected Page One attribute to the portlet header.

Define Layout For — Select the object class for which you wish to define a layout. The Default
layout applies to the object class and all its subclasses. You can also define layouts that are
subclass-specific. For example, you can define a Default layout for the Changes object class,
but define a separate layout for the ECO subclass.

Layout Template — Select either the Form or Tabbed layout template.
Available Attribute Groups — Select an attribute group and click > to add it to a form or tab.
Available Tables — Select a table and click > to add it to a form or tab.

Form — If you chose the Form layout template, use the form to arrange attribute groups and
tables.

Tab Name — Type the name of a tab name to use, and click Add to add it to the Tabs box.

Tabs — If you chose the Tabbed layout template, use the different tabs to arrange attribute
groups and tables.

Add >> — Adds the configuration to the layout.
Update >> — Updates the configuration of the layout.

Defined Layouts — Displays the layouts that have been defined for each object class. Select one
to edit it.

Note Attribute groups always display first, followed by tables, in both the Form or
Tabbed layout. This is true even if you move a table above an attribute group in
the list.
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The following figure shows the configuration for a tabbed layout.

Eportlet Configurator

Fle Edit

-1o(x]

S

Classes Configure | x|

Configure for Base Class |Changes j
Content ! :
Attribute Groups [V Display Object Status ¥ Use Partlat Header
Tables Construct Headsr |Change: [Nurmber]
ACtion Groups
Layout]
Define Layout For IDefauIt b I

Layout Template © Form & Tabbed

Tah Nare |f-‘«ttachments Add

Available Attribute Groups Tahs

J <|x]> Add>> |
=
Attachiments Uptlate >> |
Page One | affected Tisms |

Ayailable Tables
Affectad Iams

Page Ore

ﬂ Y
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The following figure shows the configuration for a form layout.

ﬁportlet Configurator 2 &
Fle Edit

=

@] B]n]

Classes Configure | v |

Configure for Base Class |Changes j
Caontent ! :
Afirbute Groups WV Digplay Object Status ¥ Use Portlet Header

Tables Construct Header |Change: [Nurnber] <Add | INu mber j

Action Graups

§

Defined Layouts
Define Layout For (Default ¥ m

Layout Termplate % Form  © Tabhed

dvailable Attribute Groups ~Form
Page One
j Page COne
Attachments Adll>>
~ X
Undate == J
Available Tables X
iffected Items i
B

Messaging Between Portlets

The portlet. messaging parameter of a portlet allows you to define how a portlet updates itself, the
page, or other portal pages. Objects that are listed in Agile portlets—such as in a Search Results
portlet—appear as standard links. When you click an object link, the portlet sends a message to its
intended target. The target can be the same portlet, the page on which the portlet appears, or
another page specified by its URL mapping. The context of the object that you've clicked is sent to
the target, which causes it to be updated.

When you modify a portlet’s portlet.messaging parameter, you can specify the following values:

u]

u]

m]

an empty string (") — uses the default portlet messaging.
page — updates the current page.

none — does not send a message to other portlets. In other words, object links in the portlet
appear as normal text.

an internal portal URL — updates another page specified by URL mapping. The URL must be all
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lower case.

Important Changes to the portlet.messaging parameter do not take effect until you log out of
the portal and log in again (to clear the cache).

If the portlet.messaging parameter is missing from a portlet or the parameter value is a null string, the
portlet uses the default portlet messaging behavior. For objects supported by the Business Object
portlet, the portlet overrides the portlet. messaging parameter and always messages to itself. For
objects that are not supported by the Business Object portlet, the default behavior is for the portlet
to send a message to the page.

If you want the Business Object portlet to message to other portlets on the same page when you
click a link for a particular class of objects, make sure

= the portlet. messaging parameter for the Business Object portlet is set to page

= the Business Obiject portlet is NOT configured to support the class. If the Business Object
portlet supports a class, it will always message to itself when you click a link for an object of
that class.

For more information on how to set portlet parameters, see Setting Agile Portlet Parameters.

Clearing Portlets If Messaging Is Not Supported

The clearPortletContentslfMessageNotSupported parameter can be used to clear the contents of a
portlet if a message received from another portlet (such as a Search portlet) is not supported. Use
the clearPortletContentsifMessageNotSupported parameter in conjunction with the portlet.messaging
parameter to determine how portlets get updated when you click a link in them.

For example, let us create a portal page with the following portlets:
@ Advanced Search
o Search Results

= Business Object Portlet - Changes (a copy of the Business Object portlet that supports only
Changes)

o Business Object Portlet - Items (a copy of the Business Object portlet that supports only Items)

Specify the following portlet parameters:

Portlet Parameter Value

Search Results portlet.messaging page
Business Object Portlet - portlet.messaging page
Changes

clearPortletContentsifMessageNotSupported true
Business Object Portlet - portlet.messaging page
ltems

clearPortletContentslfMessageNotSupported true
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Exporting and Importing Portal Configurations using XML
Configuration Interface

Note Please consult the IBM WPS Help for the latest information.

WebSphere Portal Server provides an XML configuration interface that allows you to configure the
portal remotely. The XML configuration interface is a command line tool that connects to the server
using an HTTP connection. You can use the tool to export the portal settings from a test server and
import them to a production server. The command line client is located in the <wps_root>\bin folder.
To invoke the client, use the xmlaccess.bat script.

The syntax for the xmlaccess command is as follows:
xmlaccess -in XML _file -user user -pwd password -url PortalConfigURL -out filename.xml

Note You can specify the command options in any sequence.
The xmlaccess command can be used to:
= Transfer a complete portal configuration
= Transfer a portal page
o Transfer a portal page and its portlets
o Create and modify resources

o Perform administration tasks

For more information about the WebSphere Portal Server XML configuration interface, see the IBM
WebSphere InfoCenter.

To export the WebSphere Portal Server configuration:
1. Inacommand prompt window, go to the location of the XML Configuration Interface:
cd <drive>:<wps_root>\bin

2. Run the following xmlaccess command to export the entire portal configuration to a file called
Complete.xml:

xmlaccess.bat -in ../doc/xml-samples/Export.xml -user wpsadmin -pwd wpsadmin
-url http://hostname:10038/wps/config -out Complete.xml

You can use the resulting output file as the input parameter for the xmlaccess command to import
the portal configuration on another portal server.

To import the WebSphere Portal Server configuration on another server:

1. Copy the latest AgilePortletPack2.war file to the <wps_root>\installable Apps folder of the target
server.

2. Inacommand prompt window, go to the location of the XML Configuration Interface:
cd <drive>:<wps_root>\bin

3. Run the following xmlaccess command to import the portal configuration from the Complete.xml
file that you previously exported:
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xmlaccess.bat -in Complete.xml -user wpsadmin -pwd wpsadmin
-url http://hostname:10038/wps/config -out Qut.xml

Note If the target server has a different portal administrator than the one used to
export the Complete.xml file, edit the file and change the user and pwd
parameters.

Using Process Extensions from within Portlets

Agile PLM 9.2.2.5 includes a special web service that lets you invoke Agile PLM process extensions
from within a portlet. The web service is contained in a file named PXWebService.jar, which is
installed in the following folder on the Agile PLM server:

agile_home\integration\sdk\extensions

For more information about how to develop and deploy process extensions, see the Agile SDK
Developer Guide.

To configure your portal to use process extensions:

1. Before using a process extension from within a portlet, check to make sure PXWebService is
working. Open a browser and type the following URL:

http://<server>:<port>/<virtualPath>/integration/ws/InvokePX?wsdI

For example, if you installed Agile PLM on a server named plmserver, you're hosting Agile PLM
on Oracle Application Server using port 7777, and you're using a virtual path named “Agile,”
type the following URL:

http://plmserver:7777/Aqile/integration/ws/InvokePX?wsdl

You should see a WSDL response in the browser. If you don't, the web service may not have
been deployed properly. Make sure you installed the latest Agile PLM service packs. For more
information about how to check whether Agile PLM web services are working, see the Agile
PLM installation guide.

2. Make sure that the proxy.server.url portlet application parameter has been configured correctly.
This should be the same as the URL used to access the Agile Web Client, but without the
trailing “/PLMServlet”. For more information, see Setting Agile Portlet Services Application
Parameters.

3. Portlets use Basic Authentication to invoke the PXWebService on the Agile PLM server. Make
sure the Web server used by your WebSphere Portal has Basic Authentication enabled. In
Internet Information Server, you can enable Basic Authentication from the Directory Security
tab.

Configuring a New Process Extension Action for a Portlet

When you use the Portlet Configurator to configure a portlet, you can select the actions that appear
at the top of the portlet. In addition to standard actions, like Bookmark, Delete, Print, and SaveAs,
you can add custom actions that invoke process extensions.

To configure a new process extension action:

1. Configure a portlet based on the Business Object portlet.
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2. Inthe XML Configurator window, click the Copy button to copy the configuration to the
Clipboard.

Click the Launch Configurator link to open the Portlet Configurator window.

4. Inthe Portlet Configurator Login dialog box, enter your username, password, and the Agile
PLM server URL. Click OK to log in.

The Portlet Configurator window appears.

Click @ Paste.

Click the Configure tab.
In the navigation pane, click Action Groups.
Click the New Action button.

© ©® N o g

In the Action Name field, type a name for the custom action.

10. In the Process Extension field, select a valid process extension.

Note The Portlet Configurator displays all process extensions, not just the ones that
have been assigned to a particular class. Only process extensions that have
been assigned to the class are valid.

11. If you selected a URL-based process extension (one that links to another Web page or a Web-
based application), check the Refresh Parent box if you want the parent portlet to be refreshed
after you close the process extension page. If the process extension updates the object that
launched the page, you can use this option to refresh the portlet.

12. You can now include the custom action in any Action Group.

Note In the XML, the process extension action looks like any other action but has the
ref-id "%common.invokePX". Do not modify the ID of this process extension
action.

Testing a Sample Process Extension within a Portlet

The Agile SDK includes a sample process extension, SamplePXes.jar. To obtain the source code
for SamplePXes.jar and other Agile SDK sample programs, download the Developer
Documentation Installer from the Agile Documentation Web Site (http://docs.agile.com). Follow the
instructions in the Agile SDK Developer Guide to build and deploy SamplePXes.jar in the
agile_homelintegration\sdk\extensions folder. You also need to configure the “Set Description”
process extension using the Agile Java Client.

To test the Set Description process extension from within a portlet:
1. Build and deploy the sample process extensions included with the Agile SDK.

a. Download the Java SDK from http://java.sun.com/ and install it on your development
machine.

b. Set the system variable JAVA_HOME to point to the home directory of your Java SDK
installation.

c. Download the Ant build tool from http://ant.apache.org/ and install it on your
development machine.

d. Set the system variable ANT_HOME to point to the home directory of your Ant
installation.
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e.

f.

Open a command prompt window and go to the Process Extensions samples folder
located in agile_homel\integration\sdk\samples\px.

Type the following command to build the samples:

%ANT_HOME%\bin\ant all

Ant uses the build.xml file to build the SamplePXes.jar file and then deploy it to the
agile_homel\integration\sdk\extensions folder, where all process extensions and web
service extensions are automatically deployed for clients that invoke them.

2. Enable the Set Description process extension.

a.

"m0 o200

3. Click OK.

Log into Java Client as an administrator.

Choose Settings, select Data Settings, then select Process Extensions.

Click the New toolbar button. The Add Process Extension dialog box appears.
For Type, select Internal Custom Action.

For Internal Custom Action, select samplepx.SetDescription.

Enter values in the following fields:

Name — Enter “Set Description.”

Description — Enter “Sets the description of the object.”

Initiate From — Select “Actions menu.”

Roles — Select one or more roles to use for the process extension. To use the roles
and privileges of the current user, leave the field blank.

Timeout — Use the default value (60 seconds).
Enabled — Select Yes.

4. Add the Set Description process extension to the Item class.

a.

® oo o

f.

In Java Client, choose Settings > Data Settings > Classes.
Open the Items class.

Click the Process Extensions tab.

Click the Assign toolbar button.

Select the “Set Description” process extension, and then click > to move it into the
selected list.

Click OK.

5. Inthe Portlet Configurator, add the Set Description process extension as a custom action and
assign it to the Item class.

a.

Edit a portal page that has an Item Portlet, that is, a Business Object portlet
configured for the Items class.

In the XML Configurator window, click the Copy button to copy the configuration to the
Clipboard.

Click the Launch Configurator link to open the Portlet Configurator window.

In the Portlet Configurator Login dialog box, enter your username, password, and the
Agile PLM server URL. Click OK to log in. The Portlet Configurator window appears.

Click @ Paste.

Click the Configure tab.
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g. Inthe navigation pane, click Action Groups.

h. In the Action Groups field, type “Custom Actions”.
i.  Click the New Action button.

j.  For Action Name, type “Set Description.”

k. For Process Extension, select “Set Description.”

[.  Click OK.

6. Select the “Set Description” action, and then click the > button to move it into the Selected
Actions list.

a. Click the Add button to move “Set Description” into the Custom Actions action group.

Click E Copy.

Switch to the XML Configuration window, and click Paste.
Click Save to save the configuration.
e. Click Return to return to the portlet page.

o oo

7. Invoke the Set Description process extension and verify that the Item Description is now
assigned to a random value.

a. Open a portal page that has the Iltem Portlet.

b. Search for or select an item to display data in the Item Portlet.
c. Choose Custom Actions > Set Description.

You should see the new value in the Description field.

Creating Custom Help for Agile Portlets

Because Agile portlets are so flexible and customizable, static online help files are not provided with
them. However, you can create your own custom online help files. You can choose one of two
online help scenarios for each Agile portlet:

Using Relative References to Help Files

With this scenario, all Agile portlets share the same base URL for help files. To specify the base
URL, enter the help.base.url application parameter. For each portlet, enter a value for the
help.relativePath portlet parameter, which specifies the relative path to a help file. The help handler
for Agile portlets combines the base URL and the relative URL to form the complete URL to the help
file.

For example, if the help.base.url value is http://webserver/portlethelp, the help.relativePath for the
Advanced Search portlet could be AdvancedSearch.html. The complete URL that is used to access
the file is http://webserver/portlethelp/AdvancedSearch.html.

Using Absolute References to Help Files

With this scenario, each portlet specifies its own help file. You can use the help.url portlet parameter
to override the help.base.url application parameter and the help.relative.path portlet parameter.

For example, if you created help for the Advanced Search portlet and deployed it on a Web server
named “portal”, the help.url value could be http://portal/docfiles/AdvancedSearch.html.
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Note If there is a value in a portlet’s help.url parameter, it overrides the
help.relativePath portlet parameter and the help.base.url application parameter.

Downloading Online Help Files for Agile Portlets

Agile provides HTML help files for Agile portlets. To download portlets help, open a Web browser
and go to the Agile Documentation on the Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation/agile.html.

To configure Agile portlets to use the downloaded online help files:

1. Download the help archive file for Agile portlets.

Extract all files from the help archive file.

Create a folder called AgilePortletHelp in your Web server's docroot directory.

Copy the portlet help files to the AgilePortletHelp folder.

o > w N

Set the help.base.url application parameter for AgilePortlets 2.1 to the URL for the
AgilePortletHelp folder (for example, http://\Web Server/AgilePortletHelp). For complete
instructions, see Setting Agile Portlet Services Application Parameters.

Configuring Online Help for Portlets on WebSphere Portal 6.0.1

If you want to create custom online help files for Agile portlets on WebSphere Portal 6.0.1, follow
these instructions.

To configure Agile portlets to use a base help URL on WebSphere Portal 6.0.1:

1. Setthe help.base.url application parameter for AgilePortlets 2.1. For complete instructions, see
Setting Agile Portlet Services Application Parameters.

Click Portlet Management and select Portlets.
Select an Agile portlet, and click the |#-J Configure Portlet icon.

For the help.relativePath parameter, click the [#] Edit Parameter icon.

a > w N

In the Value box, enter a URL that is relative to the help.base.url setting for Agile portlets. For
example, the value could be an HTML filename.

6. Click OK.

7. Select other Agile portlets and configure their help.relativePath parameter in the same way.

To configure an Agile portlet to override the base help URL and use its own help URL on WebSphere Portal
6.0.1:

1. Log into the WebSphere Portal Server as a portal administrator.
Click Administration.

Click Portlet Management and select Portlets.

For the help.url parameter, click the [#] Edit Parameter icon.

In the Value box, enter a help URL.

Click OK.

o g M w D
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Chapter 4
Using Agile Portlets

This chapter includes the following:

B AQIIE POMIEE FEAIUIES ...vvuiecviercers ettt ee s bbbt n et 53
= Using Edit Mode to Personalize Agile POMIELS ... s 54
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= AVANCEd SEAICH POIIEL .........ceieiceees bbb 55
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B BOOKMAIKS POMIEL ...t 59
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N O 110} oo T 0T 1) TSRS 61
= MY NOEICAHONS POIIEL.........cvcececees bbb bbb 61
5 MY TRINGS TO DO POMIEL ...ttt bbb bbb 62
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B QUICK SBAICH POMIEL.......cocvivivciicieecccce et bbbt bbbt bbbttt b bbb 65
= Report FOIAEr BIOWSEI POIIEL .........cciiiieirieieisceisie et 66
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= Search FOIAEr BrOWSET POMIEL...........coiriririiriiicisisitsessiesss st 69
= Search Results Portlet
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B UPIOAA FilE POIEL ..ot sttt

B USEI PIOFIIE POMIEL. ..ottt bbb

Sending Portlet Errors to the Portal Administrator

Agile Portlet Features

Each Agile portlet is a small Web-based application that connects to the Agile server and displays
data in tabular format. For example, Find portlets like the Quick Search portlet display a table of
search results after you click the Search button.

If you click an object’s number link in an Agile portlet, you load data in other Agile portlets, like a
Business Object portlet.

Many of the Agile portlets have common controls that let you refresh data from the server or view
an object in the Agile Web Client. Several Agile portlets let you perform relevant actions—such as
Bookmark or Subscribe—for each object listed in the portlet.

To refresh the data in an Agile portlet:

Click 2],
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Using Edit Mode to Personalize Agile Portlets

You can personalize Agile portlets as per your own personal preference. When you personalize a
portlet, it affects the portlet only for you and not for others.

The following Agile portlets can be personalized:
@ Advanced Search

@ Attachment Files

= Business Object

= My Notifications and Requests
= My Things To Do

B Quick Links

= Report Folder Browser

@ Saved Search

@ Search Folder Browser

= Single Signon

@ User Profile

Most portlets have a simple Edit mode user interface to personalize the portlet. The Business
Object and User Profile portlets both use the XML Configuration window for Edit mode, but they
also allow you to launch the Portlet Configurator to personalize those portlets. The Quick Links
portlet uses only the XML Configuration window for personalization. If you are not proficient at
editing XML, do not attempt to personalize the Quick Links portlet.

To use Edit mode to personalize an Agile portlet:

1. Select a portal page.

2. Click the ¥ Edit icon (a pencil) for a portlet.
3. Edit the configuration.

For some portlets, you can click Use Defaults to revert to the default configuration specified by
the portal administrator.

Click Save.

Click Return to return to the portlet.

Filtering Data in Portlets

The following Agile portlets provide a filter bar that lets you filter out data from tables:
@ My Things To Do

= My Notifications and Requests
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B Saved Search
B Search Results

To use the filter bar, select an attribute from the list, type a value, and then click Filter. To show all
rows in the table, click Show All.

IStatuS ;I |F‘rc\ducticun | Filter | Show all

Advanced Search Portlet

The Advanced Search portlet searches for all objects with fields that match the conditions of the
search. The portlet must be configured properly before it can be used on a page. The fields and
attributes that you can use in an advanced search depend on the class that the portlet is configured
to search. After you specify the search conditions, click Search.

Note Auto Complete will not work if there are more than ONE searchable TEXT attributes
configured: This limitation seems to only be an Internet Explorer issue. Auto Complete for
the FireFox browser works perfectly.

Using Advanced Search

The Advanced Search portlet can be personalized to search on multiple attributes for a particular
class. Each attribute appears in the Advanced Search portlet as a separate search condition. For
each search condition, specify a value.

The relational operator used for each search condition depends on the data type of its attribute, as
shown in the following table.

Data Type Relational Notes
Operator
Text Contains or Like Specify a text value. When you type a word to search for, it's

searched using the Contains relational operator. That means the
search finds all objects that contain the word in that field.

You can also use wildcard characters (* and ?) in the search
value, in which case the Like operator is used. Agile supports two
wildcards: the asterisk (*) and the question mark (?). The question
mark finds matches with any other single character. For example,
?at finds hat, cat, and fat, but not splat. The asterisk finds matches
with more than one character. For example, *at finds cat, splat,
and big hat. The asterisk by itself finds all objects of the specified
class.

Note: If you use wildcards, try to make your search as narrow as
possible. Otherwise, the search may not be able to return results
because it matches too many rows in the database.
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Data Type Relational Notes
Operator
Date Greater Than or Equal Specify starting and ending date values. The relational operator
To, Less Than or used in the search depends on the range of dates you specify. If

Equal To, or Between you specify only the starting date, the search finds any date values
that are greater than or equal to it. If you specify only the ending
date, the search finds any date values that are less than or equal
to it. If you specify both the starting and ending dates, the search
finds any date values that fall within the specified range.

List Equal To Select one or more list values. If you select multiple list values, the
search constructs multiple search conditions in the background
and connects them using the OR logical operator. For example, if
you select “Production, Prototype” for the Lifecycle Phase attribute
(as shown above), the search returns items whose Lifecycle
Phase is equal to “Production” or “Prototype”.

Money Equal To Specify a numeric value to search, not a currency code. When you
run the search, money values are converted to the company’s
corporate currency to determine if they match the value you
specified.

MultiList Contains Select one or more list values. The search finds any matches that
contain any of the specified list values, not all of them. If you
select multiple list values, the search constructs multiple search
conditions in the background and connects them using the OR
logical operator. For example, if you select “Equipment, PDA” for
the Product Line(s) attribute (as shown above), the search returns
items whose Product Line(s) field contains “Equipment” or “PDA”".

Numeric Equal To Specify a numeric value to search.

uoM Equal To Specify a numeric value, not a unit of measure. For example, if the
value you are searching for is “5.0 Gram”, type “5” or “5.0".

The logical operator AND is used between multiple search conditions that you specify. For example,
in the Advanced Search screen, the following logic applies:

Search for Items where

[Title Block.Number] is Like PO017* AND
[Title Block.Description] Contains BOARD AND
([Title Block.Lifecycle Phase] is Equal To "Production” OR

[Title Block.Lifecycle Phase] is Equal To "Prototype™) AND

([Title Block.Product Line(s)] Contains "Capricorn” OR

[Title Block.Product Line(s)] Contains "Leo") AND

[Title Block.Rev Incorp Date] is Between 02/01/06 and 05/01/06
When you finish specifying values to search for, click Search.

To save your search so you can reuse it later, click [E save Search.

To clear search criteria and start a new search, click Clear.
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OR Searches

To do an “or” search, type two words separated by a space. For example, “FUSE TRANSISTOR”
will find all objects that contain either “FUSE” or “TRANSISTOR” in that field.

AND Searches

To do an “and” search, type a second word prepended with a plus sign. For example, “INTEL
+PENTIUM” will find all objects that contain both “INTEL” and “PENTIUM” in that field.

Note Do not put a space between the plus sign and the second word. For example,
“INTEL + PENTIUM” is not a valid search value.

AND NOT Searches

To do an “and not” search, type a second word prepended with a minus sign. For example, “INTEL -
PENTIUM” will find all objects that contain “INTEL” but not “PENTIUM” in that field.

Matching Exact Phrases

To do an “exact match” search, type a word or phrase surrounded by quotes. For example, “LOAD
BALANCER” will find all objects that contain the exact phrase “LOAD BALANCER” phrase in that
field.

You can’'t combine “exact match” searches with “and” or “or” searches. For example,
“LOAD BALANCER” +IBM

is not a valid search value.

Personalizing the Advanced Search Portlet

The Advanced Search portlet has slightly more complex Edit mode options than other Agile portlets.
You can select one of the defined searches, and specify the search fields and output fields.

To personalize the Advanced Search portlet:

1. Select a portal page with the Advanced Search portlet, and click the ¥* pencil icon to enter Edit
mode.

2. Select one of the defined searches.

3. Select fields to search, and then click the ® right arrow to move them into the Selected
Attributes box.

4. Select search output fields, and then click the * right arrow to move them into the Selected
Attributes box.

5. To remove a field from either of the Selected Attributes lists, select it and then click the ¥ left
arrow.

6. Click Update to update the search.

Click Return to return to the portlet.
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Edit Mode Options

Option

Description

Select Search

Select one of the predefined searches.

Select Fields to Search

Select search attributes by moving them into the Selected Attributes list.

Select Search Output Select attributes that appear in the search results. Move attributes from the

Fields Available Attributes list to the Selected Attributes list. You can also sort
attributes by moving them up or down in the Selected Attributes list.

Update Saves the configuration.

Return Returns to the page without saving. To save the configuration, make sure you click
Update first.

Use Default Uses the default search criteria.

Configuration

Configure Mode Options

Option

Description

Select Class to Search

Select the class used to search for objects.

Define Search For

Select the class you are defining search criteria for.

Select the Attributes to
Include as “Advanced”
Search Parameters

Select attributes that users can use to search. Move attributes from the Available
Attributes list to the Selected Attributes list. You can also sort attributes by
moving them up or down in the Selected Attributes list.

Select Attributes to
Display in the Search
Results

Select attributes that appear in the search results. Move attributes from the
Available Attributes list to the Selected Attributes list. You can also sort
attributes by moving them up or down in the Selected Attributes list.

Add or Update

Creates or updates the search definition.

Exclude Inactive Values

To exclude any inactive list values from search results, make sure this box is

for List Attributes checked.
Save Saves the configuration.
Return Returns to the page without saving.

Attachment Files Portlet

Shows a selected object’s Attachments table. To use the Attachment Files portlet, you must first
use one of the Search portlets to find an object with an Attachments table, such as an item or
change. You can use the Attachment Files portlet to open, download, add, checkout, cancel
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checkout or check-in a file, as well as click a file to view it in the Agile Viewer.

= pttachment Files {Agile) - PO0243 + & 2 -0
J Edit 2|
Reay: IIntru:--:Iu-:tn:urt,I ‘I
Attachments
add * | Clipboard ™ | ¥ Remove |'E LS 1-1/1 M4 IE kM
r |‘ﬂ_“| WRPLC_Z2,0_Train_MRD_Template.doc Release doc 312,832 Actions =
MRELD

Fowsz per page ; |10 -

To display the attachments table, select values for the Site and Rev. By default, the portlet shows
all sites and the Introductory revision.

Edit Mode Options

Option Description

Available Attributes Lists available attributes for the table.

Selected Attributes Lists attributes you selected.

Save Saves the configuration.
Return Returns to the page without saving.
Use Defaults Uses the default configuration.

Configure Mode Options

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option.
See Edit Mode Options (on page 58). When you save settings in Configure mode, they become the
default settings for the portlet.

Bookmarks Portlet

Shows the current user’s Agile PLM bookmarks. You can define new Agile PLM bookmarks from
Agile PLM clients, including the following Agile portlets:

o Business Object
B Saved Search

B Search Results

Agile Bookmarks are also listed in the Quick Navigation portlet.
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Business Object Portlet

Shows data for Agile PLM business objects (such as items or change orders). Easily the most
powerful and most customizable of Agile’s portlets, the Business Object portlet allows you to create
portlets that display different types of Agile PLM business objects. The Business Object portlet can
be configured to support multiple object classes. You can use the Portlet Configurator to customize
the content and layout of the portlet, selecting the presentation of data appropriate for your users.

Note For the Business Object Portlet, the PX menu Configuration in the Configurator
is assigned to Base Classes, not Classes or Subclasses.

The Business Object portlet supports the following Agile PLM classes:
@ Changes

@ File Folders

= Items

o Manufacturer Parts

@ Manufacturers

= Programs

= Reports

o User Groups

Additionally, the Portlet Configurator allows you to configure the Users class to support the User
Profile portlet.

Other portlets, such as the Search Results portlet, can message to the Business Object portlet to
update its content when you click an object link. After you view a series of different objects in the
Business Object portlet, you can use the “breadcrumbs” feature at the top of the portlet to backtrack
to previously viewed objects.

" L usinacs Cbject Portlet [Agile) - 1222-02

Part: lﬂ\illﬂ-ﬂz F Part: 1543-01 P Part: 1232-02

Actions ™

For information on how to use the Portlet Configurator to configure the Business Object portlet, see
Using the Portlet Configurator (on page 31).

Note Using "Transfer Authority","Change Password" and "Change Approval Password" in the
Business Object Portlet generates a "This portlet is unavailable" error. The "Edit" and
"Print" actions are fine.

Note To add a file attachment to an object displayed in the Business Object Portlet, make sure
you have Modify privileges to the File Folder’s Title Block > Description field.
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Clipboard Portlet

Lets you collect Agile PLM objects to later perform actions on them.

I“i"’'C|i|:||:u:|.5|rn:| [Agile) ? -0

2]
E}--_‘."l:-u have S record(s) in your Clipboard
Objects in Clipboard

* rRemove Empty ¥ xLs 1-5/5 H 4 IEP M
TR | | |
I_ ﬁ £800-03 ZAP PDA 5127256 P3 CO0146

- o Z-555-34 Eve Motion and Blinking Activated PDA Introductary

I_ ﬁ £-634-76 Voice Activated PDA 01 Cco0i43

I_ ﬁ FOO1F2 MEMOREY BOARD A CO0041

I_ ﬁ FOO1TF7 12-BIT, 240 ¥ 320 BRIGHT TRAMSF.., & CO0041

Rows per page ¢ [10 =

The Clipboard is a temporary storage portlet for the user’s current portal session. Each user can
store different things in the Clipboard. You can manage the list of objects in the Clipboard to quickly
retrieve objects. When you first log in, the Clipboard is empty. When you add objects to the
Clipboard, they remain there until you empty the Clipboard, click Remove or Empty to remove them,
or terminate the portal session.

Do not confuse the Clipboard portlet with the Windows Clipboard. You cannot use the Clipboard
portlet to copy and paste objects to the Windows Clipboard. It is used only to copy and paste
objects between Agile portlets.

You can add objects to the Clipboard from other Agile portlets. Select one or more rows and then
choose the Copy To Clipboard action.

On any editable table in the Business Object portlet, you can use the Clipboard > Paste action to
paste the contents of the Agile Clipboard into the table. Although the Agile Clipboard may contain
disparate objects (such as Items and Changes), only objects supported by the table are pasted.

Note You do not need to place the Clipboard portlet on a portal page to take
advantage of the Clipboard functionality available in other Agile portlets.

My Notifications Portlet

Shows the current user’s notifications. Notifications appear as separate views in the portlet
(although the portal administrator can choose to not display both).

If you click a Subject link in the My Notifications portlet, the portlet displays a detail view of the
notification.
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The table actions available in the My Notifications portlet vary based on the view that is selected.

View Available Table Actions
My Notifications Delete, XLS (Save Table to Excel)
My Notifications - Detail Delete

Configure Mode Options

Option Description

Available Views Lists available views for the portlet;

My Noatifications

Selected Views Lists views you have selected.
Save Saves the configuration.
Return Returns to the page without saving.

My Things To Do Portlet

Shows objects routed to the current user that he must act on. The My Things To Do portlet
consolidates Action Items, Workflow Routings, and Program Activities within one portlet (although
the portal administrator can choose to not display all three views). You can update your
assignments by marking them complete or entering a completion percentage.

4 * - 0

=]

My Action Items (1) | My Workflow Routings (27 | My Program Activities (0]

bl My Things Ta Do [Agile)

Display Due Int [All -
vl Accept K Decline Q Mark Complete Maore ™ 1-1/1 M 4 IE (]
ISubject ;I | | Filter | Shaw All
Meed to Mot 2005-04-  Maguire,
schedule Accepted 25 Paul (pm)
design review 00: 0000
meeting

Fows per page : |10 =

The table actions available in the My Things to Do portlet vary based on the view that is selected.
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View Available Table Actions
My Action ltems Accept, Decline, Mark Complete, Edit, XLS (Save Table to
Excel)
My Workflow Routings XLS (Save Table to Excel)
My Program Activities Edit, XLS (Save Table to Excel)
My Requests Accept, XLS (Save Table to Excel)

My Requests - Detail

Delete, Reject

Displaying Things To Do by Due Date

You can display Action Items or Program Activities based on the date they are due. Click the Display

Due In list and select All, 1 Week, 2 Weeks, 1 Month, 2 Months, or 6 Months.

Configure Mode Options

Option

Description

Available Views

Lists available views for the portlet;
= My Action Iltems

o My Workflow Routings

= My Activities

Selected Views

Lists views you have selected.

Save

Saves the configuration.

Return

Returns to the page without saving.

Quick Links Portlet

Lets you add links to other portal pages or to external Web pages. When you click a link, the page
can display within the portal or it can open within a new browser window.

e Suick Links [Agile)
External Links
Agile Software

Google
vahaoo

-f"

&

?

- O

You can use the Quick Links portlet to provide users a quick way to navigate to a page for
information on how to complete a task, or provide a link to another Web application.
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Edit Mode Options

Option Description

Copy Copies the XML configuration.

Paste Pastes the XML configuration.

XML Configuration Defines the XML configuration for the portlet. For more information, see
Configuring a Quick Links Portlet (on page 29).

Save Saves the configuration.
Return Returns to the page without saving.
Use Defaults Uses the default configuration.

Configure Mode Options

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option.
When you save settings in Configure mode, they become the default settings for the portlet. See
Edit Mode Options (on page 58) above.

Quick Navigation Portlet

Lets you navigate to bookmarked or recently visited Agile PLM objects, or objects that you copied to
the Clipboard portlet.

o Recently Visited — During each Agile PLM session, the server maintains a list of the last 10
objects viewed (or 25, 50, or 100, depending on the server’'s Preference settings).

@ Bookmarks — Agile PLM clients, including portlets, allow you to bookmark objects to later return
to them quickly.

Note The Bookmarks portlet also lists Agile PLM bookmarks.

= Clipboard — Collects Agile PLM objects to later perform actions on them. You can use the Agile
Clipboard (not to be confused with the Windows Clipboard) to copy and paste objects between
Agile portlets.
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If you click an object link in the Quick Navigation portlet, it automatically updates the object
reference for portlets on the current page. Because the Quick Navigation portlet does not have a
portlet.messaging parameter, you cannot configure it to update the object reference for portlets on
other pages

L Cuick Mavigatian [Agile) ? -0
2|
=8 Quick Mavigation =
El@ Recently Yisited
Po0171
ECO4_100
23478
23450
1750-01
1232-02
POO172
102-1194-01
1051-09
101-1194-01
POOOOZ
POOQO1
- POOLEB
Elm Bookmarks
1000-02
1051-09
1059-03
1232-01
1543-02
1750-01
2543-01
POOOOS
SW4E7E-01
Z800-01
I'_—'I@ Clipboard
1232-02 |

1750-01 |E|

Quick Search Portlet

Searches for Agile PLM objects by specifying a single matching value.

e Guick Search [Aagile) T - 0

[ =]

[T search Attachment Contants

The Quick Search portlet lets you quickly locate objects in the Agile system that match the text you
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enter. The text must be the start of the ID number you are seeking or the beginning of a word within
the object’s description. Quick Searches are not case sensitive.

Select a class to search. Type the value to search for, and then click Search. The results appear in
the Search Results portlet.

Note For Quick Searches, the display fields that appear in the Search Results cannot be
configured.

To perform a full-text search of files listed on the Attachments tab of objects, make sure the Search
Attachment Contents box is checked.

Note Auto Complete will not work if there are more than ONE searchable TEXT attributes
configured: This limitation seems to only be an Internet Explorer issue. Auto Complete for
the FireFox browser works perfectly.

Using Wildcards

You can use wildcard characters in your search. Agile uses two wildcards: the asterisk (*) and the
qguestion mark (?). The question mark finds matches with any other single character. For example,
?at finds hat, cat, and fat, but not splat. The asterisk finds matches with more than one character.

For example, *at finds cat, splat, and big hat. The asterisk by itself finds all objects of the specified
class.

Note If you use wildcards, try to make your search as narrow as possible. Otherwise,

the search may not be able to return results because it matches too many rows
in the database.

Configure Mode Options

Option Description
Available Object Lists available object types for the Quick Search portlet.
Types
Selected Object Lists object types you selected. The order is important. The first object
Types type listed is the default one used in the portlet.
Save Saves the configuration.
Return Returns to the page without saving.

Report Folder Browser Portlet

Lets you generate reports from one of the Report folders. To generate a report, click any of the
listed reports to open the Report wizard.

Page - 66 Agile Product Lifecycle Management



Chapter 4

The Report Folder Browser portlet can be used on multiple portal pages, and you can configure
different settings for each page. This allows you to specify different root Report folders on different
pages.

I""i"“th:n:\rt Falder Brawzer [Agile) £ £ 7 - 0

Click ta select the Report fram the Report Tree below EI
E|--3"\_J Prograrm Reports
¥l Bazeline Cormparizon Repaort

Program Action Iterms Report

Program Celiverable Gate Report

EJ Pragram Detail Report

Program Docurments Report

EJ Program Milestones and Phase Review Report
Program Off Track Activities

Pragram Schedule Report

Program Top Discussions Report

¢ Program Udser Assignments Report

Edit Mode Options

Option Description
Report Tree Displays a hierarchical list of report folders. Select
one to use for the portlet.
Save Saves the configuration.
Return Returns to the page without saving.
Use Defaults Uses the default configuration.

Configure Mode Options

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option.
See Edit Mode Options (on page 58). When you save settings in Configure mode, they become the
default settings for the portlet.

Important The Enable Customer External Reports checkbox option is not supported. Do not check that
box.
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Saved Search Portlet

The Saved Search portlet displays results for a saved search.
+ 7 = O

2|

M aued Search [Aaile)

Changes Submitted by Me

Copy B w1z B Bockmark Mare ¥ 1-1/1 M4 IE" H

INuml:-er ;I | | Filter | Show All

B tomber || actons
4 CO0207 Adjust colar per customer Pending Default Change Orders ECO

- [

Fows per page : |10 =~

The Saved Search portlet must be configured properly before it can be used on a page. The portal
administrator should make a copy of this portlet before adding it to a page and configuring it for a
particular saved search.

Click an object’s number to load its data in another portlet, such as a Business Object portlet. You
can also perform relevant actions for each object listed, such as Copy, Bookmark, and XLS (Save

Table to Excel).

Note The Saved Search portlet does not support parameterized searches, which
prompt for search criteria when you run them.

Configure Mode Options

Option Description
Search Tree Displays a hierarchical list of search folders and searches. Select
a saved search to use for the portlet.
Save Saves the configuration and returns to the page.
Return Returns to the page without saving.
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Search Folder Browser Portlet

Allows you to browse search folders and select a particular search to run.

= Search Folder Browser (Agile) |

- O
Zlick ta select the Search from the Search Tree below r‘bl
and wiew the results in Search Results Paortlet

= Program Searches
Q, Root Level Programs
Q, off-Track Activities by Program
Q, Deliverables by Program
Q, Discussions by Program
Q, open Action Ttems by Program
Q, attachiments by Program
Q, My INn-Process Activities
Q My Mot Started Actvities

2rganize wour Personal Searches,

You can run any saved searches from the Search Folder Browser portlet, including parameterized
searches, which prompt for search criteria when you run them.

To remove searches from your Personal Searches folder, click the Organize Your Personal Searches
link at the bottom of the portlet. Select a search, and then click Delete. After that, click Return to go
back to the normal portlet view.

Note For searches that you run from the Search Folder Browser portlet, the display
fields that appear in the Search Results are determined by how the searches
have been defined.

Edit Mode Options

Option Description
Search Tree Displays a hierarchical list of search folders. Select a
search folder from the tree to use for the portlet.
Save Saves the configuration and returns to the page.
Return Returns to the page without saving.
Use Defaults Uses the default configuration.

Configure Mode Options

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option.
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See Edit Mode Options (on page 58). In Configure mode, the Search Tree is used to select the
base search folder for the portlet.

Search Results Portlet

Works in conjunction with the Advanced Search, Quick Search, and Search Folder Browser portlet.
When you run a search in one of the search portlets, the results appear in the Search Results
portlet.

= earch Results [Agile] 2 =N E

2|

Quick Search Results

Copy P& x5 U Bookmark More ¥ 1-10/ 112 M 4 IEP H
IName.-"Nurnl:-er;I | | Filker | Show All

CEnE | L |
I_ ﬁ POO1&T HERE IS5 & MUMBER: -130037302 Praliminary

I_ ﬁ POO1GE HEEE IS5 & MUMBER: -114344869 Praliminary

r @ Pooies Praliminary

r O POOie4 Pralirminary

r O Pooies Praliminary

r O Pooisz Part with attachments [C-M) Praliminary

r O PoOOisl part with an attachment C-M Praliminary

r g Zso0o0-0z ZAP PDA S12/256 Prototype

|— E £800-02 ZAP PDA 256/128 Prototype

|— E £800-01 ZAP PDA 1258/64 Prototype g

FRows per page : |10 =

From the search results, you can click objects to display them in another portlet, such as the
Business Object portlet. You can also perform relevant actions for each object listed, such as Copy,
Bookmark, and XLS (Save Table to Excel).
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Single Signon Portlet

Allows single sighon between the portal and the Agile PLM server.

e Single Signon [Agile]

agile Welcome to Agile

The Agile Credentials have been zet for the Uzer with Agile Uzer ID - jefip.
You can change the Agile Credentialz by clicking the Edit Made of thiz Portlet,

About Agile Portets:

Agile PLM Server:  http://grange.agile.agilesoft corni 7775/ Agile
Build: 2005-04-13,16-13-24,432

Minirnurn Agile PLM Server Wersion:  Agile PLM 9, 1LASP1

& =0

Configure the Single Signon portlet to specify the user ID and password used to connect to the
Agile PLM system. This same connection can be used for every Agile portlets page on the portal.

If you use Edit mode to change the Agile PLM user ID and password, make sure you log out and

log back into the portal.

Note If you do not configure the Single Signon portlet correctly, other Agile portlets

will not work.

Edit Mode Options

Option Description

Agile User ID The user’s unique ID for logging into the Agile PLM system.

Agile User Password | The user’s login password.

Save Saves the configuration.

Cancel Cancels configuration changes.
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Upload File Portlet

Adds new files to the Agile PLM system. Specify the path of each file to upload, or click Browse to

select it.
= Upload File (4gile) ? -0
Add New Files to Agile PLM
Click "Browse" ta select a Filas
O:Mfileshpa®ladw_rmodel_image.jpg Elrowse
Ditfiles\15512.bmp | Browse.. |
D:Mfiles\specs_for_amMP_utility.doc | Browse.. |
| Browse.. |
| Browse.. |
Type:
IFiIe Folder v|
Description:
¥ Upload Files to the same File folders,
[ Unzip all zip files and add them as individual files.
| Upload File |
Options
Option Description
Browse Select a file to upload.
Upload Files to the To upload files to the same folder, check this box. Otherwise, a separate
Same File Folders folder is created for each file.
Unzip all Zip Files and If the file is a Zip file (an archive format), check this box to unzip the file
Add Them as Individual | when you upload it.
Files
Type Select the File Folder type.
Description Enter a brief description of the file.
Upload File Creates a file folder containing the specified file. After the file is uploaded,
click Done to return to the portlet.
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User Profile Portlet

Lets you view and edit the Agile PLM user profile for the current logged in user. The User Profile
portlet is based on the Business Object portlet, but it is specifically for the User class.

For information on how to use the Portlet Configurator to configure the User Profile portlet, see
Using the Portlet Configurator (on page 31).

Note If you change the password in the User Profile portlet, make sure you reset the
password used in the Single Signon portlet as well.

Sending Portlet Errors to the Portal Administrator

If an error occurs with an Agile portlet, the following message appears:

The system did not perform as expected. Please contact your Portal Administrator.

If you see such a message, there should also be a link below it that reads Send Error To Portal
Administrator. Click the link to open your default email client and send the contents of the error
message to the portal administrator.

Note The portal administrator’'s email address must be specified in the portalAdministratorEmail
application parameter. For more information, see Setting Agile Portlet Services
Application Parameters.
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Troubleshooting

This chapter includes the following:
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Error Conditions

I get an APIException.getRootCause message for all portlets

When you try to display any portlet, an APIException.getRootCause message appears in the
portlet.

Solution:
1. Make sure that the proxy.server.url parameter is correct and Agile PLM server is running.

2. Tryto connect to http://plmserver.company.com:7777/Aqile/ServerAPIProperties. If you can’t
connect, there is a problem with the Agile PLM server. HTTP ports may be configured
inconsistently between the Agile PLM server and the Oracle Application Server (OAS). For
more details about HTTP port settings for OAS, see the Agile PLM Installation Guide.

3. If you updated the Agile PLM server or updated the Agile SDK JAR files, make sure you clean
up the Agile SDK cache on the portal server. To clean up the cache, the portal administrator
should stop the Portal Server and delete the AgileSDK.cache folder under c:\documents and
settings\<user>\Local Settings\Temp.

Cannot find bundle for base name com.agile.util.ejb.AGILE_JNDI

When you try to display any portlet, a “Cannot find bundle for base name
com.agile.util.ejb.AGILE_JNDI” message appears in the portlet.

Solution:

This is probably caused by a problem connecting from the portal to your application server. Make
sure

o You can ping the application server.

o You specified the fully qualified domain name of the application server when you installed Agile
PLM 9.2.2.5 and when you set portlet application parameters such as the proxy.server.url
parameter.

@ HTTP ports are configured consistently on the application server. For details about HTTP port
settings for Oracle Application Server, see the Agile PLM Installation Guide.
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o You are trying to connect to an Agile PLM 9.2.2.5 application server and not a server from a
different Agile release.

= You have cleared the Agile SDK cache. If you updated the Agile Portlet Services WAR file on
your portal server, your portal server may be using older class files and therefore cannot
connect to the updated Agile PLM server. See Clearing the Agile SDK Cache (on page 15).

This object has been modified, please refresh and try again

You were unable to save changes to an object due to an error. You clicked the error icon for a
description of the error, and the following message box appeared: “This object has been modified,
please refresh and try again.”

Solution:

The object was modified by another user after you entered Edit mode, preventing you from saving
your changes. To re-enter your changes, do the following:

1. Click OK in the message box to close it.

2. Click Cancel to exit Edit mode and cancel your changes.

3. Click ] Refresh to refresh the object with the latest data from the server.
4. Choose Actions > Edit to enter Edit mode.

5. Re-enter your changes, and click Save.

When | add a file attachment to an object in the Business Object portlet, an error appears: “Cell
[Title Block.Description] is read-only”

When you add a file attachment to an object in the Business Object portlet, you may see this error if
you do not have appropriate privileges for the File Folders class. The file attachment was added
successfully, but the Title Block > Description field of the associated File Folder could not be updated.
Make sure you have Modify privileges to the Title Block > Description field for the File Folders class.

Please select some BaseClasses first

In the Portlet Configurator, | have selected an object class on the Classes tab, and then clicked the
Configure tab. An error message appears: “Please select some BaseClasses first!”

Solution:

Although you selected an object class, you did not click Add to define a class view. After you click
Add, the portlet title you entered appears in the Defined Class Views list.

This Portlet Instance has not been configured

You tried to configure an Agile portlet in the page layout, and the following error appeared: “This
Portlet Instance has not been configured. Please use the Configure or Edit Mode to set the required
conf